
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
  

     User Guide               Updated May 2014 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 





 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  TC2000 12.4 USER GUIDE   
 
 
 
 
 
 
 
 

Worden Brothers, Inc. 
www.Worden.com 

 
PO Box 1139 

Wilmington, NC 28402 

http://www.worden.com/
http://www.worden.com/


 
 
 
 
 
 
 
 
 
 

Copyright 
 

© 2014 Worden Brothers, Inc. 
 

All rights reserved. Printed in the United States of America. Except as permitted under the 
Copyright Act of 1976, no part of this publication may be reproduced or distributed in any 
form or by any means, or stored in a database or retrieval system, without the prior written 

permission of the publisher. 
Information has been obtained by Worden Brothers, Inc. from sources believed to be 

reliable. However, because of the possibility of human or mechanical error by our sources, 
Worden Brothers, Inc. does not guarantee the accuracy, adequacy or completeness of any 
information contained herein and is not responsible for any errors or omissions or the results 

obtained from the use of such information. 
 

www.Worden.com  
Worden Brothers, Inc.  

P. O. Box 1139 
 Wilmington, NC 27707 

Customer Service: 1-800-776-4940 
Technical Support: 1-919-408-0542 

Fax: 1-919-408-0545 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Updated May 2014 

http://www.worden.com/


Worden Brothers, Inc. | TC2000 v12.4 User Guide 55 

 

TC2000 v12.4 User Guide 
 
 
 
 

Welcome......................................................................................................................................... 1 

Accessing TC2000 v12.4 ................................................................................................................... 2 

What's New in TC2000 v12.4 ........................................................................................................... 3 

TC2000 v12.4 Account Management ................................................................................................ 4 

Terms to Know ................................................................................................................................ 5 

Layout Tabs ..................................................................................................................................... 7 
What is a Layout Tab? .......................................................................................................................................... 7 
Customizing a Layout Tab..................................................................................................................................... 8 

Adding Windows to a Layout Tab .................................................................................................................... 8 
Repositioning and Resizing Main Toolbar ........................................................................................................ 9 
Tool Window Controls ..................................................................................................................................... 9 

Creating New Layout Tabs ................................................................................................................................. 12 
Saving and Retrieving a Layout Tab .................................................................................................................. 13 
Layout Tab Groups ............................................................................................................................................ 13 
Floating a Window ............................................................................................................................................ 14 

Charts ........................................................................................................................................... 15 
What is a Chart? ................................................................................................................................................ 15 
Charts Button (Main Toolbar) ........................................................................................................................... 15 
Controlling the Active Ticker Symbol ................................................................................................................ 16 
Activating Scrolling Ticker ................................................................................................................................. 16 
Chart Display Settings ........................................................................................................................................ 17 

Price Graph Type ........................................................................................................................................... 17 
Chart Timeframe ........................................................................................................................................... 19 
Chart Scaling ................................................................................................................................................. 19 
Chart Aesthetics ............................................................................................................................................ 22 

Crosshairs .......................................................................................................................................................... 23 
Indicators and Plots in TC2000 .......................................................................................................................... 24 

Adding Plots to a Chart ................................................................................................................................. 24 
Managing Plots on a Chart ............................................................................................................................ 26 
Viewing Historical Charts .............................................................................................................................. 26 

Chart Toolbar .................................................................................................................................................... 27 
Saving and Retrieving a Chart ............................................................................................................................ 28 

WatchLists .................................................................................................................................... 29 
What is a WatchList? ......................................................................................................................................... 29 

Selecting a WatchList .................................................................................................................................... 29 
WatchList Menu Categories .......................................................................................................................... 29 

WatchLists Button (Main Toolbar) .................................................................................................................... 30 
Sorting a WatchList ........................................................................................................................................... 30 
Creating and Deleting a WatchList .................................................................................................................... 32 
WatchList Aesthetics ......................................................................................................................................... 32 
Related Items WatchList ................................................................................................................................... 33 
Controlling the Active Symbol ........................................................................................................................... 33 



56 TC2000 v12.4 User Guide| Worden Brothers, Inc. 

 
EasyScans ...................................................................................................................................... 34 

What is an EasyScan and How Does it Work? ................................................................................................... 34 
EasyScans Button (Main Toolbar) ...................................................................................................................... 35 
Initiating an EasyScan from a Chart ................................................................................................................... 35 

Indicators ...................................................................................................................................... 36 
What is an Indicator? ........................................................................................................................................ 36 
Indicators Button (Main Toolbar) ...................................................................................................................... 37 
Change Indicator Data Source ............................................................................................................................ 37 

Conditions ..................................................................................................................................... 38 
What is a Condition? ......................................................................................................................................... 38 
Conditions Button (Main Toolbar)..................................................................................................................... 39 

Financials & Stats .......................................................................................................................... 40 
What are Financials & Stats and How Do I Use Them? ..................................................................................... 40 
Plotting Historical Fundamentals ...................................................................................................................... 41 

Columns ........................................................................................................................................ 42 
What are Columns and How do They Work? .................................................................................................... 42 

Drawing Tools ............................................................................................................................... 45 
Drawing Boards ................................................................................................................................................. 46 
Creating Alerts from Drawing Tools .................................................................................................................. 46 

Alerts ............................................................................................................................................ 47 
What are Alerts and How Do they Work? ......................................................................................................... 47 

Notes & News ............................................................................................................................... 49 
Notes & News in the TC Classic Layout Tabs ..................................................................................................... 49 
Creating Notes for Charts .................................................................................................................................. 50 
Notes & News Button (Main Toolbar) ............................................................................................................... 51 
Peter Worden Notes & Reports ......................................................................................................................... 52 

User Groups .................................................................................................................................. 53 
What are User Groups and How Do They Work? .............................................................................................. 53 

Appendix: Personal Criteria Formulas ............................................................................................ 54 
Boolean vs. Equations - Make PCFs More Versatile .......................................................................................... 54 
Equation Templates........................................................................................................................................... 55 
Using Subtraction vs. Division ........................................................................................................................... 56 
PCF Syntax Basics .............................................................................................................................................. 57 

Example - Range vs. Average Range ............................................................................................................. 57 



 

Welcome 
Welcome to the updated TC2000 v12.4!  
 
TC2000 is a market analysis software that has been designed to combine an easy-to-use interface with 
feature flexibility, so that with little prep time, you can start to use the software to enhance the way you 
trade. 

 
This reference should serve as a guide to software features and their implementation. The guide is 
designed to discuss the logistics of designing a personal trading environment, from screen real estate 
manipulation to charting and organizational functionalities. This guide should provide you with a firm 
foundation upon which to build. 

 
There are no trading strategies or instructions here; this guide offers no trading advice, so you should not 
make any trading decisions based on any information contained here. 

 
Should you encounter inaccuracies or material that requires correction, please feel free to make note of 
needed modifications.  Send such notes to support@TC2000.com. 

 
Call TC2000 toll-free to set up a TC2000 account or to have questions about an existing account answered. 
(800) 776-4940 
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Accessing TC2000 v12.4 
 
 

To access TC2000 v12.4 visit www.TC2000.com. 
 
 
 

If you are a current TC2000 customer with TC2000 service... 
 

Enter your Username or Email and Password when prompted. You will be logged in to TC2000.com, which is a 
browser-based version of TC2000. There is no difference in functionality between TC2000.com and the 
downloadable TC2000 application. 

 
If you would prefer not to work in a browser- 
based environment and would like to have a 
program file and desktop icon-accessible 
version of TC2000 on your computer, choose 
Install to My PC or Install to My Mac from the 
sign-in screen at www.TC2000.com. 

 
If you have created WatchLists, saved Charts, 
written PCFs, or have created EasyScans in a 
previous version of TC2000 or 
FreeStockCharts.com, those items will be 
available to you for use in TC2000 v12.4. You 
will be prompted to import previous settings 
when running TC2000 v12.4 for the first time. 
If for some reason your personalized items are 
not available for use when you open TC2000, 
select Import TC2000 v7 from the File Menu to 
initiate the import process. 

 
 
 

If you are not a current TC2000 customer and do not have a TC2000 login: 
 

Create a new account by providing requested information located within the Create Account section of the sign-
in screen at TC2000.com. 

 
When prompted, provide a Screen Name, Email Address, Password, and First and Last name. Then choose 
Create Account.  Next, either choose to activate a 14 Day Trial and select a post-trial service level. This will 
allow you to explore the features of TC2000 and pay for the service after the free trial expires. 

 
If you would prefer not to work in a browser-based environment and would like to have a program file and 
desktop icon-accessible version of TC2000 on your computer, choose Install to My PC or Install to My Mac from 
the sign-in screen at www.TC2000.com. 

 
Note:  To manage any and all account settings from inside TC2000 v12.4, select the My Account option from 

the Help Menu. 
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What's New in TC2000 v12.4 
 
 

1. Charts are up to 300% faster. As you spacebar through any WatchList, you’ll notice snappy 
charts that load instantly. Alerts are also faster and easier to manage. 
 

2. Whether you’re working with one monitor or four, floating windows will give you a ton of 
new options for laying out your research. 

 

3. Full multiple monitor support. Drag any Layout Tab window onto any monitor. No 
limitations on the number of monitors and setups can be saved for future use as Layout 
Tab groups. 

 

4. The new Add Plot button (shortcut key ‘/’) allows you to browse a library of all available 
chart data that can be plotted including Technical Indicators, Fundamental data, Sector 
and Industry Indexes, Market Indexes, Breadth Indicators, Exchange Traded Funds, Forex, 
and additional Symbols. 

 

5. An upgraded pointer mode allows you to select a date and view detailed chart data for all 
chart indicators at that specific point in time. For charts with different timeframes, notice that 
the pointer now works across charts. 

 

6. Data box details have been expanded to include descriptive figures for chart spans. Drag the 
pointer between any two points on the chart to measure number of bars, performance, and 
annualized returns. 

 

7. Drawing Tools are now on every chart. Click the Paint Palette in the upper-right corner of any chart 
to open the Drawing Toolbar. Fibonacci Projections have been added to the library of available 
drawings. When drawing Trendlines, hold the Shift key and drag to draw perfectly horizontal lines. 

 

8. Drawings can now be assigned to specific Drawing Boards, which act as layers that keep 
drawings of different types separate. Any of the eight boards can be toggled on or off at any 
time for any chart. Use the Scratch board for a particular chart template to jot thoughts and 
drawings that might not need to be available for use on any other templates. 

 

9. Apply technical indicators to anything - including historical fundamentals, sectors, industries, 
T2 market indicators, or any other technical indicator. 

 

10. Historical fundamental data can now be plotted and used for sorting and EasyScans. 
Fundamental figures such as sales, dividends, and key ratios include 25 years of historical 
data. 

 

11. Open a Related Items WatchList to learn more about any symbol. You’ll see any Indexes and 
Exchange Traded Funds the current symbol is a part of. You’ll also have immediate access to 
lists of all the stocks that share the same Sector or Industry category.  New Morningstar 
Sectors & Industries as well as Breadth Indicators (T2s) now stream in real-time. 

 
12. The Worden Notes & Reports are easier to access and more efficient to use. 
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TC2000 v12.4 Account Management 
 

To access and/or change account information in TC2000, select the My Account option from the Help Menu. 
The My Account option enables you to manage your TC2000 subscription quickly and easily from inside the 
software. 

 
From My Account, biographical info, service level / account status, certain program defaults, alert notification 
preferences, and active exchange information can be assigned. Account management options have been 
expanded substantially from previous version of TC2000, so make sure to take a look! 

 
There are two main service levels 
available: Gold and Platinum. Software 
functionality is the same whether you are 
a Gold or Platinum customer, but 
features available vary from one service 
level to the other. 

 
Gold customers have access to streaming 
real-time data from the BATS Exchange. 
Price charts and indicator values for Gold 
customers will, therefore, update intra-
day in TC2000 v12.4.  Manual updates of 
price and volume data are no longer 
required at the Gold level. Each trade that 
takes place on the BATS Exchange is 
displayed in real-time for all stock Charts. 
Full-market data, which is reflective of 
trades on all of the major American 
exchanges, is never more than 15 minutes 
delayed. 

 
Note that results of Scans and Sorts for 
Gold customers are based on delayed 
data and are not reflective of broad 
market real-time Price and Volume 
information. 

 
Platinum customers access true full-market streaming real-time data that reflects trades across all of the major 
American exchanges.  Scan and sort results for Platinum customers are always reflective of the latest real-time 
data available. Pre- and post-market data, live bid and ask markers, unlimited real-time alerts, streaming 
EasyScan results, intraday time frames for scan conditions and PCFs are all exclusive to Platinum TC2000. 
Platinum customers are also able to participate in Platinum User Groups, which provide an environment for 
interactive dialog with other users and Peter Worden, one of the co-founders of Worden Brothers, Inc. and 
TC2000. 

 
Data Feeds and Exchanges associated with a subscription include US Stocks and Indexes, Canadian Stocks and 
Indexes, Forex, Mutual Funds, Pink Sheets, and Bulletin Boards. 
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Terms to Know 
 
 

Layout Tab 
The term Layout Tab refers to a group of tool windows, which may be floating, tabbed with one another, or 
docked into a specific screen position.  Layout Tabs may contain many items at a time - like several Charts, 
more than one WatchList, News and Notes, a User Group window, etc. As long as tool windows are contained 
within the same Layout Tab, the items can all be described as one Layout Tab. 

 
Layout Tab Group 
A Layout Tab Group is a collection of Layout Tabs, saved under one name, that when accessed subsequently 
opens the set of Layout Tabs as a group. 

 
Pre-Built 
There are several types of Pre-Built items in TC2000 v12.4. Pre-Built Charts, scans, indicators, Conditions, and 
column sets, can all be accessed and used. Pre-Built items are built and maintained by TC2000; libraries of Pre-
Built items may change at any time.  All Pre-Built items can be implemented within the software in the same 
way as a personally created item of the same type. 

 
Chart 
A Chart is a grouping of indicators/plots.  Charts always begin with a Price History plot and can have as many 
other indicators or plots added to them as are desired. Plots on a Chart may be stacked on top of one another, 
contained within individual panes – they may also be overlaid, such that many (related or unrelated) plots are 
resident within the same pane.  A Chart always has its own toolbar, and its indicators are all controlled by the 
same Timeframe and Zoom and Pan slider settings. 

 
Indicator 
An indicator is a graphical plot displayed within a Chart's pane.  Indicator values are displayed along the x 
(time) axis in increments determined by the Timeframe assigned to the indicator's Chart; values are displayed 
along the y (value) axis as is determined by scale settings. 

 
Timeframe 
The Timeframe selected within the Timeframe drop-down of a Chart at any time dictates how much 
information is included in each plotted bar of data on the Chart. When the Timeframe is set to 1 Day as is the 
default setting, Price History bars show 1 Day of trading information at a time.  If this Timeframe were changed 
to 1 Week, each bar shown on the Chart would represent an entire week’s trading activity. Each Chart has its 
own Timeframe drop-down. 

 
Zoom and Pan Slider 
This slider gives you control over how much historical information is displayed on a Chart at a given time.  To 
zoom out, and view more historical data values for your indicators, grab the left-most handle of the slider and 
drag it to the left, enlarging the size of the slider. Also try using the scroll wheel on your mouse to zoom in or 
out on Chart data. To change the historical period in view, grab the entire slider, and drag it to the left or right. 

 
Active Symbol 
The Active Symbol is the symbol for which information is displayed on a particular Chart. Each Chart can have 
its own Active Symbol. 
WatchList 
A WatchList is any group of tickers that is displayed as a list inside a WatchList window.  Click any item within a 
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WatchList to display its information on all Charts that either share its symbol color group or do not belong to a 
symbol color group.  WatchLists can be sorted by symbol, indicator value, or stocks that meet a specified 
Condition. 

 
Condition 
A Condition is a user-defined entity that describes a specific behavior for an individual Indicator or the 
interaction between more than one indicator. A Condition can be used to identify stocks that are actively 
exhibiting the behavior defined, by either including the Condition in a scan - or by sorting a WatchList by the 
Condition. One or more Conditions can be incorporated into any scan. 

 
Sort 
To sort is to arrange (rank) the items in a WatchList by some assigned criteria. WatchLists can be sorted by 
symbol, indicator value, or markers for stocks that meet a specified Condition. 

 
EasyScan 
To scan is to apply a Condition, or a set of Conditions to a WatchList of items in order to identify those - if any - 
that meet the behavioral criteria of the Condition(s). Only the WatchList items that pass all scan Conditions 
remain in the list's results when the scan is active. 

 
Alert 
An alert is a notification that a monitored behavior is underway. Alerts can be emailed, or text messaged and 
are based on the real-time passing of a user-defined Condition, price-level, or interaction with a Trendline. 

 
User Group 
User Groups (Platinum only) are channels of communication between multiple TC2000 users. It is possible to 
communicate with others individually through Private Messaging, or as a group through User Groups. 
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Layout Tabs 
 
 

                                                                                 WHAT IS A LAYOUT TAB? 
 

Layout Tabs are collections of windows that can be arranged any way you want. Windows can contain 
different types of content, like Charts, WatchLists, News, Notes, Chat, Drawing Tools, etc. As long as tool 
windows are contained within the same Layout Tab, the items can all be described as one Layout Tab. 

 
Version 12.4 provides two default Layout Tabs called TC Classic and TC Classic+, each of which was designed to 
meet common Charting needs in an easy to use way. 

 
 
 
 
 
 
 
 

TC Classic 

TC Classic is a great Layout Tab for 
basic Charting needs. Click a stock in 
the WatchList to view its Chart and 
any associated News or Notes. 

 
Easily add Indicators, flip through 
Charts, and do some research. 

 
 
 

TC Classic+ has everything TC Classic 
has, plus some useful tools. Click one 
of the Indexes in the top-left 
WatchList; view the stocks that make it 
up in the WatchList below. 

 
Then choose a stock within that center 
WatchList and view its Industry and Sub- 
Industry families in the upper-right 
corner WatchList. 

 
 
 

TC Classic+ 
Stick any symbols of interest into the 
Flagged and My Favorites WatchLists 
tabbed in the middle right. As you find 
symbols you like, remember Shift-F 
will flag a symbol or group of symbols, 
and Shift-V will send a symbol or group 
to the My Favorites list. 

 
If you're a Platinum user, check out 
what other users are saying in the All- 
TCNet Chat; if you have a question, let 
us know in the Help Forum, and keep 
an eye on important upcoming 
Corporate Calendar events - all in the 
bottom-right corner windows. 
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As a collection, TC Classic and TC Classic+ are called the Factory Default Layouts. (A Layout Group is a collection of 
Layout Tabs). You can access the Factory Default Layouts again at any time by File > Open Factory Default 
Layouts. 

 
You can create your own Layout Tabs and 
have as many open at a time as you would 
like. 

 
When Layout Tabs are open, the tabs are in 
the row of tabs along the bottom of the 
application. Click any Layout Tab to fill the 
TC2000 application window with its content. 

 
The default Layout Tabs can be altered to best suit your needs. Existing windows can be tweaked or deleted, and 
new windows can be added. TC2000 provides a fully customizable trading research environment. 

 
 

                                                                        CUSTOMIZING A LAYOUT TAB 
 
 

Adding Windows to a Layout Tab 
The elements that can be added to a Layout Tab are tool windows, which contain different types of 
information, including Charts, WatchLists, Drawing Tools, Alert Monitor, User Groups, News & Notes, etc. You 
have the freedom to add as many windows as you want by either tabbing or docking them to the Layout Tab. 
These tools provide you with the flexibility to customize your research and trading environment, so that the 
information displayed works best for you. 

 
Many of the items listed above are items with representative buttons located on the Main Toolbar. To add a 
tool window to a Layout Tab, select the Main Toolbar button which contains the type of content the window 
should display.  Note that while Drawing Tools are present on each chart, a separate drawing tool window can 
be accessed and added by the Tools 
menu. Indicators, Conditions, 
Financials, and Columns can be found 
within the Library button. 

 
Content within the Main Toolbar 
menus is categorized into Personal 
and Pre-Built Libraries. Locate an 
item of interest from one of the Main 
Toolbar menus, select it, and a 
window containing its content will be 
added to the Layout Tab. 

 
Tool windows added to Layout Tabs in this way are added as undocked windows, meaning that they can be 
moved freely within the Layout Tab screen real estate and are not attached or docked to any other window 
within the Layout Tab. It is, however, possible to assign a position to any undocked window by tabbing or 
docking it to another window within the Layout Tab. 
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Repositioning & Resizing Main Toolbar 
 
Reposition 
To change the main toolbar position from the horizontal default 
to a vertical bar along the left side of the program, click the 
small icon at the extreme left of the horizontal toolbar. Select 
Left and the tool bar is repositioned. 
 
 
 
Resize 
To change the main toolbar size click the small icon at the 
extreme left of the horizontal toolbar. Select Images Only or 
Text Only and the tool bar is resized accordingly. Resizing can be 
applied to either the horizontal or vertical Main Toolbar 
position. 

 
 

Tool Window Controls 
 

Move 
There are three options for the position of any window within a 
Layout Tab. The window can either be left undocked, tabbed 
with or docked relative to another window or set of tabbed 
windows. The Move button (and its drop-down), located in the 
upper-right corner of every window provides the ability to assign 
any window's position. Using the Move button, you can literally 
setup any Layout Tab and its windows in any desired 
configuration. 

 
As new windows are added to Layout Tabs, they are floating. To 
assign a semi-permanent position to the window (semi-
permanent because the window will stay where assigned until 
you manually move its location) select the Move button. 

 
Docking 
Docking a window places it adjacent to another window or group of 
windows already docked within a Layout Tab. When the Move button 
is clicked, multi-directional arrows are displayed within each docked 
window. Simply select the arrow that corresponds to the new, 
desired placement of the window being docked. Note that arrows 
are displayed at application extremes as well, which can be used to 
place windows along the entire length of the application window. 
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Tabbing 
Tabbed windows are like sheets of paper stacked atop one another. Each window in a tabbed set has a 
representative named tab. Select the tab for any of the tabbed windows to display that window's content. 
When the Move button is selected, a Tab option is 
displayed within each docked window. Select the Tab 
option within the window with which the current window 
should be tabbed. 

 
Once two or more windows are tabbed with one another, 
not only is the original Move button present in the upper-
right corner of each window; a master Move button is also 
visible. Should you ever want to move the entire group of 
tabbed windows to a new location within the Layout Tab, use 
the master Move button using the same operating principles as 
you would with the original Move button to move the complete 
tabbed set. 

 
Undocking 
Should you wish to undock a window that is currently docked or tabbed 
within the Layout Tab, use the Move button drop-down, and select 
Undock. 
 
 

Full Screen Mode (Maximize) 
The Move button drop-down also includes a Maximize option. 
Select to view the window's content in full-screen mode.  As an 
alternative, you could use the Shift-L shortcut to maximize the 
content of a window. Repeat the Shift-L command to return the 
window and its content to its original position within the Layout 
Tab. 

 

 
 

Delete 
The Delete button located in the upper-right corner 
of every window provides the ability to close the 
relevant tool window and cease displaying its 
contents on-screen. 

 
 
 
 
 

Tool Linking 
Some types of tool windows can be linked by Symbol; others can be linked by Timeframe.  When windows are 
linked, it means that a change made to one window will cause the same change to be reflected in the other 
window. 
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Linking Symbols 
WatchLists, Charts, EasyScans and Notes & News windows all have 
a Symbol Linking icon located in the upper-right corner of each 
window. Symbol linking works on the premise that windows can 
be assigned to symbol linking color groups. Windows that share 
the same color group assignments are linked by symbol. That 
means a change to the active symbol of one of the windows in the 
symbol linking color group initiates the same change in all of the 
other windows that belong to the same color group.  If you set 
more than one window to the same symbol linking color, when you 
change the symbol in one window, you'll change the symbol in the 
other window. 

 
Color groups for WatchLists and Charts can be assigned using the 
symbol linking drop-down. There is a total of 8 color groups. 

 
Chart symbol linking drop-downs have two extra options: Listen For any Symbol Changes and Not Linked. 
Select Listen For any Symbol Changes if you want any symbol assignment within the Layout Tab to change the 
active symbol for the "listening" window. Select Not Linked if you want the active symbol of the window to 
remain constant without regard for new symbol assignments elsewhere within the Layout Tab. 

 
Some windows have two Symbol Linking icons, one in the upper-left and one in the upper-right corner of the 
window. For such windows, the color group assigned in the upper-left corner dictates which symbol content 
will be displayed within the window; the color group assigned 
in the upper-right corner dictates the symbol that will be sent 
to other windows. Essentially, the left icon controls symbol 
input and the right icon controls symbol output. 
 
Linking Timeframes 
Charts all have a Timeframe Linking icon located in the upper-
right corner of each window. Timeframe linking works on the 
premise that Charts can be assigned to Timeframe linking color 
groups. Windows that share the same color group assignments 
are linked by Timeframe.  That means a change to the 
Timeframe of one of the Charts in the Timeframe linking color 
group initiates the same change in all of the other windows that 
belong to the same color group. 

 
There is a total of 8 timeframe linking colors. In addition, Listen For any 
Timeframe Changes and Not Linked options are available.  Select Listen 
For any Timeframe Changes if a change to any Chart within the Layout 
Tab should change the Timeframe of the "listening" window. Select Not 
Linked if the Timeframe of the Chart should be independent of changes 
made to the Timeframes of other Charts within the Layout Tab. 
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Save 
Chart tool windows and EasyScans contain a Save button located in the 
upper- right corner of the window. Select the Save button, and choose the 
appropriate item from the menu displayed. Basic Save and Save As 
options are available. 

 
 
 

Change List/Scan Properties 
In the case of WatchLists, select the Change List/Scan Properties 
icon to view a list of available options, including Edit Columns, 
Load Columns, Save Columns, Set WatchList as System Default, 
and Properties. 

 
 
 
 

Load Columns 
In the Change List/Scan Properties drop down menu, there is a Load 
Columns button. Choose this option to view a list of available Column 
Sets, including any personally saved and Pre- Built sets. 

 
 
 
 

Change Symbol or View Chart 
WatchList windows also contain a Change Symbol or View Chart 
button. For WatchLists with representative Charts (like Indices), 
select either the Change Symbol or Open Chart option from the 
menu provided to view a Chart of the associated symbol's plots. 
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                                                                       CREATING NEW LAYOUT TABS 
 

It is also possible to create new, customized Layout Tabs from scratch using a pre-configured design called a 
Starter Layout Tab.  There are two ways to generate a new Layout Tab: the New button, Layout Tab option; or 
the Add Layout Tab button to the right of the Layout Tabs located along the bottom of the application window. 
Either method generates the Select a Layout Tab dialog, where you can choose an appropriate Layout Tab 
design from the collection of Starter Layout Tabs displayed. 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
Incidentally, saved Layout Tabs and copies of the TC Classic 
and TC Classic+ Layout Tabs can also be opened by the 
Select a Layout Tab dialog. 

 
Once a Starter Layout Tab is selected, a formatted Layout 
Tab containing blank windows is displayed, and each 
window can be filled with any standard window content, 
including Charts, WatchLists, EasyScans, Notes & News, 
Drawing Tools, an Alerts Console, User Group, or Private 
Message. 

 
When a Layout Tab is opened, its contents are displayed as 
they were last saved.  Layout Tab content will fill the entire 
TC2000 application screen.  

 

Note that opened Layout Tabs create additional 
Layout Tabs along the bottom of the TC2000 
application screen. Multiple Layout Tabs can be 
opened at once. To view the content of any Layout Tab listed as 
a tab along the bottom of the screen, select the Layout Tab's tab, 
and its contents will appear on-screen. 

 
 
Right-click any Layout Tab to Float, Duplicate, Save, Rename or 
Close the Layout Tab. You can also rearrange the tab order. 
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SAVING AND RETRIEVING A LAYOUT TAB 
 

To save a group of windows as a Layout Tab, right click on the Layout 
Tab at the bottom of the Layout and select Save Layout Tab from the 
menu. Provide a name for the Layout Tab when prompted, and select 
Save. 

 
If working with a previously saved Layout Tab, you may choose to save 
a new version of the Layout Tab by selecting Save As from the menu. 

 
If opened in the future, a saved Layout Tab will display windows as 
they were displayed when last saved. 

 
To open a previously saved Layout Tab click the New button in the 
Main Toolbar, Layout Tab option; or the Add Layout Tab button to the right of 
the Layout Tabs located along the bottom of the application window. (See 
above). 

 
Note that you can have as many Layout Tabs open at a given time as you 
would like.  Each Layout Tab will be represented by a named tab located along 
the bottom of the TC2000 application window.  Select any Layout Tab name 
to view its contents inside the TC2000 application window. 

 
Also note the Layout Tab History option listed in the File Menu. Periodically, the 
TC2000 application saves a backup of your work.  Auto-saved versions of your work 
can be accessed by the Layout Tab History option. 

 
 
 
 

                                                                                       LAYOUT TAB GROUPS 
 

A Layout Tab Group is a collection of Layout Tabs saved under one name. To 
save a collection of Layout Tabs as a Layout Tab Group, select Save Layout Tab 
Group from the File menu.  To open a previously saved Layout Tab Group, 
select Open Layout Tab Group from the File menu. 

 
When a previously saved Layout Tab Group is opened, all Layout Tabs 
associated with it are opened and populate as they were the last time the 
Layout Tab Group was saved. This includes multiple monitor configurations. 

 
The Factory Default Layout Tabs, TC Classic and TC Classic+ can always be 
opened as a group of Layout Tabs by the File menu. Choose Open Factory 
Default Layout Tabs to close any open Layout Tabs and view only TC Classic 
and TC Classic+. 
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FLOATING A WINDOW 
 
To float any Layout Tab for use as a separate window or on an additional 
monitor, click the Float button at the top right of the undocked window. 
 
In any existing window in a Layout Tab, you can click 
the Drop Down Arrow next to the Move button and 
choose Float in New Layout Window. 
 
 
 
With either of these methods, you’ll notice a change 
in the style of the window. The new window is now 
independent of the main Layout Tab and can be 
viewed even with the main Layout Tab minimized. 
You will see multiple windows present in your 
computer taskbar. Floating windows can be 
minimized, maximized, or left floating on any 
monitor. 
 
 
To move the Floating Window to another monitor, simply 
click on the upper border of the window and drag it to the 
desired monitor. 
 
 
 
Each floating window is a true Layout 
Window. You can add tools to it by docking 
and tabbing as previously described. Once 
you have the multiple windows set up the 
way you desire, you can save it as a Layout 
Group. This will retain the configuration as 
you have set it up. 
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Charts 
 
 

  WHAT IS A CHART? 
 

A Chart is a grouping of indicators/plots.  Charts always begin with a Price History plot and can have as many 
other indicators or plots added to them as are desired. Plots on a Chart may be stacked on top of one another, 
contained within individual panes – they may also be overlaid, such that many (related or unrelated) plots are 
residents of the same pane.  A Chart always has its own toolbar, and its indicators are all controlled by the 
same Timeframe and Zoom and Pan slider settings. 

 
 

  CHARTS BUTTON (MAIN TOOLBAR) 
 

The Charts button located on the Main Toolbar provides access to a library of any and all system Charts, 
including those that have been created and saved personally as well as those that were created and added to 
the library by TC2000 

 
Select the Charts button to view the Charts dialog.  You may either manually locate a Chart of interest using the 
scroll bar along the right edge of the dialog, use the My Charts and Pre-Built Charts sub-category menus, or you 
can type to search for a desire Chart by keyword. 

 
To expand one of the sub-category menus, select the plus sign 
located next to the sub-category name of interest. To 
collapse the sub-category menu, select the minus sign located 
next to the sub-category name of interest. 

 
Charts that you create and save will be stored in the My 
Charts sub-category within the Charts button of the Main 
Toolbar. 

 
Charts created and added by Worden will be located within 
the Pre-Built Charts sub-category of the Charts button. 

 
Any of the My Charts can be assigned an F1-F12 hotkey, can 
be re-named, or can be deleted from the My Charts menu. 
Use the hotkey drop-down, the edit icon, or the delete icon 
to accomplish these tasks, respectively. 
 
Any of the Pre-Built Charts can be assigned an F1-F12 hotkey 
directly from the Pre-Built Charts menu.  
 
Note that in addition to opening personally saved and Pre-Built Charts from the Charts button, it is also possible 
to open a basic Chart containing only Price and Volume data from this location as well. Select the 
Blank Chart button to open a floating Chart window that may either be left as-is or can be edited to include 
content of interest to you. 
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  CONTROLLING THE ACTIVE TICKER SYMBOL 
 

To assign a symbol for a Chart, one option is to select a symbol from a WatchList that shares a symbol linking 
color group with the Chart. Click any symbol in a linked WatchList to display information for the selected 
symbol on a Chart. 

 
Press the spacebar on the keyboard to navigate sequentially through a WatchList, assigning a new active 
symbol with each new selection from the WatchList. Hold down the Control (Ctrl) key and press the spacebar 
to move backward through the WatchList. Use Backspace to move sequentially backward through your recent 
viewing history. 

 
Alternatively, to change the symbol for a Chart, jump to a symbol in one of the following ways: 

 
Typing Shortcut 
To jump to any ticker symbol in the system, simply start typing any part of 
the symbol or company name. The smart search feature will narrow the 
list to only those items containing the letters typed. To jump to the 
desired Chart, type the complete symbol and press the Enter key or click 
the symbol or company name when it appears in the smart search list. 

 
Optional J Key 
For TC2000 users who may be accustomed to and wish to use the 'J" key to get the "Jump to" dialog, you may 
set up that option in TC2000 by the System Defaults option within the Tools menu.  Select the radio button 
next to Use TeleChart 2007 Hot Keys within the TC2000 Options dialog. 

 
Note that if there are multiple Charts open within the Layout Tab, you will need to click somewhere within a 
specific Chart's background to ensure that it is the window in focus and will be the recipient of the subsequent 
symbol change. 

 

 Activating Scrolling Ticker 
 
 

Toggle Scrolling Ticker 
To activate a scrolling list of symbols across the 
top of your TC2000, click on the Tools Menu on 
the main toolbar and choose Show Scrolling 
Ticker. 
 

Edit Scrolling Ticker 
To edit the Scrolling Ticker click on the Edit button at the extreme right of 
the scrolling ticker window. Use this window to choose any WatchList in 
your TC2000 to scroll using the drop down. Change the speed (faster or 
slower) with the slider bar. Choose Show Volume if you want to see the 
Volume displayed along with the Ticker, price, net/percent change and 
Company Name for each entry. 
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 CHART DISPLAY SETTINGS 
 
 

Price Graph Type 
Price information can be displayed in several different styles, which are described individually below. Left- 
click the Price plot, and select the Edit option in order to assign a style to the Price plot. 

 
Line 
The Price plot has four components available for each 
time increment: Open, High, Low, and Close. The Line 
plot style draws a point at the Price Close value for 
each date, as illustrated in the graphic below. Each 
point is then connected by a line to the next point on 
the Chart. The connecting line has no data behind it; 
the line's only purpose is to connect the values of 
sequential data points. 
 
 
 
OHLC Bar 
The Price plot has four components available for each time 
increment: Open, High, Low, and Close. The OHLC Bar plot style 
only displays all four of the available pieces of Price information 
for each date or time: Open, High, Low, and Close. For each 
historical date, the OHLC Bar draws a vertical line connecting the 
Price High and the Price Low for the date. A left-facing tick or 
hash is drawn at the level of the Price Open for the date, and a 
right-facing tick or hash is then drawn at the level of the Price 
Close for the date, as labelled in the graphic below. 

 
 
 
 
 
 
      HLC Bar 

The Price plot has four components available for each time 
increment: Open, High, Low, and Close. The HLC Bar plot style only 
displays three of the available pieces of Price information for each 
date or time: High, Low, and Close. For each historical date, the HLC 
Bar draws a vertical line connecting the Price High and the Price 
Low for the date. A right-facing tick or hash is then drawn at the 
level of the Price Close for the date, as labelled in the graphic 
below. 
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CandleStick 
The Price plot has four components available for each time 
increment: Open, High, Low, and Close. The Candlestick 
plot style displays all four components of Price for each 
historical date. 

 
A candlestick may either be opaque or transparent. An 
opaque candlestick represents the four Price components 
as labelled in the graphic below. A transparent candlestick 
represents the four Price components as labelled in the 
graphic below. 
 
Bar 
The Bar plot style is typically used to display non-Price data (i.e. indicator 
values) in a specific style. The Bar plot style draws a solid column from 
zero to the indicator value for each date or time, depending on the time- 
period increment. Time-period increment is determined by the bar 
interval assigned to the Chart. 

 
 
 
     Area 

The Price plot has four components available for 
each time increment: Open, High, Low, and Close. 
The Area plot style draws a point at the Price Close 
value for each date. Each point is then connected by 
a line to the next point on the Chart, much like the 
Line plot style. The Area plot style then fills the area 
above or below the Close line, as illustrated in the 
graphic below. 

 
 

Heiken-Ashi 
The Price plot has four components available for each 
time increment: Open, High, Low, and Close.  Heiken-Ashi 
Charts look similar to candlestick Charts in that four 
elements are plotted for each bar. Each bar's four 
elements are a factor of both the current available bar 
information and the previous bar's information, according 
to these rules: 

1. Close price: the average of open, close, high and 
low price from the current bar. 

2. Open price:  the average of the open and close of 
the previous candle. 

3. High price: the high price is chosen from either the high, 
open or close price, whichever has the highest value. 

4. Low price: the low price is chosen from either the 
high, open or close price, whichever has the 
lowest value. 
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Chart Timeframe 
The Timeframe drop-down sets the amount of time associated with each bar. If 
set to 1 Day the Chart will plot a daily Chart with one trading day assigned to 
each bar. All of the Timeframes in TC2000 are calendar based. As a result, a 
weekly Chart assigns one trading week to each bar (some bars may not contain 
five days of trading if there was a market holiday). 

 
To the right of every Timeframe listed within the drop-down, is the hotkey 
associated with that Timeframe. Pressing the hotkey on the keyboard 
changes the Timeframe of the Chart. For example, press the 1 key on the 
keyboard to change to a daily Chart.  Press the 5 key to change to a weekly 
Chart. 

 
Intra-day Timeframes have two-key combinations for their hotkeys, 
including CTRL and a numeric key. 

 
(See the Tool Linking section of this user guide for more information 
about grouped Chart Timeframe assignments.) 

 

 
 
 

Chart Scaling 
All indicators have scales - both horizontal and vertical. An indicator is nothing more 
than a series of points plotted along corresponding horizontal and vertical 
coordinates. Both the horizontal (date scale along the bottom of the Chart) and the 
vertical (values of the plot) scales contribute to the way the indicator's values are 
displayed on the Chart. You have control over many scale display characteristics.  To 
access the properties of a scale display, right-click the scale for the plot and make the 
desired selection. 

 

Scaling Method 
The first four options visible when viewing the Scaling menu describe scaling methods. 

 

Arithmetic 
Each scale unit is a fixed distance from the next scale unit on the Scale Display. Each scaling interval 
represents the same distance or change in variable value. 

 

Logarithmic 
Displays scale units on a logarithmic scale where the distance between each scaling unit on the Scale Display 
is an automatically determined fixed percentage. This percentage value will vary depending on the volatility 
of the data displayed on the Chart. 

 

Percent 
Displays scale units with equal spacing, which each represent a set percentage distance from one another. 
This percent change value is not assignable by the user. 

 

Fixed Percent 
Displays scale units with equal spacing, which represent a set percentage distance from one to another. 
This percent change value is assignable by the user. 
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Increase or Decrease Grid Spacing 
The next two options available when viewing the Scaling menu are Increase grid spacing and Decrease grid 
spacing. For any of the scaling methods discussed above, it is possible to increase the distance between scaling 
markers by selecting Increase grid spacing. This might be a good option if the scale looks cluttered and is hard for 
you to read.  It is also possible to decrease the distance between scaling markers by selecting Decrease grid 
spacing. This may be a good option when there is not enough scaling detail. An easy shortcut to this process is to 
hover your cursor over the scale and use the scroll wheel on the mouse to increase/decrease grid spacing. 

 
 

Show Ruler 
The final option visible when viewing the Scaling menu is to Show Ruler. The Ruler provides a way to measure 
performance relative to a user-specified location on a Chart.  
When Show Ruler is first selected, a percentage scale is made 
visible and a set of cross-hairs are added to the Chart. 
Left-click anywhere within the Chart background to change the 
position of the cross-hairs. The center of the cross-hairs is the 
location from which relative performance will be measured. The 
value outlined on the percent change scale represents the percent 
change in Price value from the location selected with the cross- 
hairs to the last data point available on the Chart. 

 
You might also choose to view performance across a period of 
time in Net or Hundred Dollar terms. Select the N or $ buttons 
visible when showing the Ruler to assign which mode the Ruler 
should display.  The Net option displays performance across the 
specified period of time in dollars. If the Price has dropped $3.72 
since the point on the Chart pin-pointed by the cross-hairs, the 
value scale for the Ruler reads -3.72. 

 
The Hundred Dollar option displays the current account value for a hypothetical initial investment of $100 at 
the location on the Chart pin-pointed by the cross-hairs. The value outlined on the Hundred Dollar scale 
represents the current number of dollars associated with the trade, with no adjustments made 
for commissions and fees. If the latest Price available for the Chart is higher than the location 
pin-pointed by the cross-hairs, the value outlined on the scale will be greater than 100; if the 
latest Price available for the Chart is lower than the location pin-pointed by the cross-hairs, the 
value outlined on the scale will be between 0 and 100. 

 
 
 

Ruler Settings 
You have the ability to automate cross-hair behavior to some 
extent for the Ruler.  Right-click the Ruler scale when visible or 
right-click within the background area of a Chart and select 
Ruler Settings to see a list of available options. 

 
 

Center on Yesterday's Close 
This selection automatically snaps the cross-hair location for 
the Ruler to the Close Price yesterday. It is still possible to 
left-click any other Chart location to view a temporary set of 
cross-hairs whose current regular Chart scale values and 
Ruler scale values will be highlighted and outlined. 
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Center on Left of Chart 
This selection automatically snaps the cross-hair location for the Ruler to the Close Price of the first visible Price 
bar on the Chart. Change the zoom level of the Chart (zoom out or in), and the position of the cross-hair will 
automatically be re-assigned. It is still possible to left-click any other Chart location to view a temporary set of 
cross-hairs whose current regular and Ruler scale values will be outlined. 

 
Center on Pointer Date Close 
This selection automatically snaps the cross-hair to the Close Price associated with any Price bar selected. Click 
and drag to change the pointer's location date, and the cross-hair center location will snap to the Close Price 
associated with that bar.  It is still possible to view regular and Ruler scale values for any location pointed to by 
clicking the background area of the Chart. 

 
Manual 
The Manual selection is the default mode for the Ruler, and operation in manual mode is as described above in 
the Show Ruler section. 

 
 
 
 
 

Date and Scale Margin Sliders 
 

 
Charts are auto-scaled by default, meaning that the highest value visible 
across the period of time associated with the Zoom and Pan settings is 
identified as the top scale value for the Chart, and the lowest visible value 
across the period is identified as the bottom scale value for the Chart. Having 
this as the default method ensures that each Chart will take up as much 
vertical space as is available within the Price pane. Chart data also occupies all 
available horizontal space on a Chart by default. 

 
There are two sets of sliders available, which allow you to make adjustments 
to the amount of vertical and horizontal space a Chart's data occupies. These 
sliders are called the Date and Scale Margin Sliders. Located at the top and 
bottom of each pane's left-most scale are two left-facing arrow heads, which 
can be grabbed and dragged with a mouse. Dragging one of the arrow heads 
changes the upper scale limit for plotting and the lower scale limit for plotting. 
Essentially, this provides a way to condense visual information into a narrower 
vertical range. 

 
Located at the right end of each Price scale, to the left of the bottom Scale 
Margin Slider is the Date Margin Slider. It is represented by an upward facing 
arrow head, which when grabbed and dragged makes future date space 
available on the right end of a Chart. This space can be useful as trend 
projection space, etc. 
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Chart Aesthetics 
Right-click anywhere on a Chart, and select Chart Properties then Colors & Grid to view the Chart Color and Grid 
Settings dialog. The following controls are available for making Chart altering Chart appearance. 

 
Back Color Drop-Down 
Assign the background color for a Chart. Use the drop-down to 
select the desired color. 

 

Gradient Drop-Down 
Assign a gradient or fade color for the background of a Chart. 
Place a checkmark next to the Gradient drop-down and select 
the desired color. 

 

Value Grid Line Slider 
Assign level of opacity of horizontal value lines associated with 
scale markers. Slide to the left to make Value Grid Lines invisible; 
slide to the right to make Value Grid Lines completely opaque. 

 

Date Grid Line Slider 
Assign level of opacity of vertical value lines associated with date 
and/or time information on the Date Scale. Slide to the left to 
make Date Grid Lines invisible; slide to the right to make Date 
Grid Lines completely opaque. 

 

Symbol Watermark Slider 
Assign level of opacity of the Symbol Watermark for the Chart, 
which includes Symbol, Company Name, Industry, and Sub-Industry 
information for the Active Symbol. Slide to the left to make the Symbol 
Watermark invisible; slide to the right to make the Symbol Watermark 
completely opaque. 

 

Value Scale Size Slider 
Assign relative size of the vertical Value Scale(s). Slide to the left to 
decrease the size of the Value Scale(s); slide to the right to increase the 
size of the Value Scale(s). 

 

Date Scale Size Slider 
Assign the relative size of the horizontal Date Scale. Slide to the left to 
decrease the size of the Date Scale; slide to the right to increase the size 
of the Date Scale. 

 

Date Scale Location Drop-Down 
Assign position of the Chart's Date Scale. The Date Scale can either be 
located horizontally along the bottom of the Price pane or can be located 
horizontally along the bottom of the entire Chart (below the bottom 
pane associated with any Chart.) 

 

Date Margin Value 
Assign the amount of future date open Chart space for a Chart. Increase the value to move Price and indicator data 
to the left, displaying future date space with no data, which may be made useful as projection space. 

 

Apply to... 
Settings assigned by this dialog can be attributed to All Charts in this Layout Tab, All Charts, or set as the Default for 
new Charts within the menu provided for this option. 
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  CROSSHAIRS 
 

 
To activate a temporary Crosshair on the Chart and view values 
for all Chart indicators relative to the position of the crosshairs, 
hold the left mouse button down and drag the cursor to the 
desired location on the Chart. The crosshair pointer shows the 
scale values on vertical scales.  The values for each indicator 
displayed on the Chart for the bar defined by the cursor are 
shown in the data box at the top left of the Chart. Release the 
mouse button to disable the temporary crosshair pointers and 
data box. 
 
Click the background of a chart to activate the pointer. Select a 
date to view detailed chart data for all chart indicators at that 
specific point in time. Data box details have been expanded to 
include descriptive figures for chart spans. Drag the pointer 
between any two points on the chart to measure number of 
bars, performance, and annualized returns.  
 
 
 
For charts with different timeframes, notice that the 
pointer now works across charts. Place the pointer on a 
longer timeframe bar, and the pointer highlights the 
relevant chart history on all shorter timeframe charts. 
 
 
 
 
To keep the Crosshair Pointer and the data box on the 
screen (without the mouse) press the Period key once 
for just the crosshairs and twice for both the crosshairs 
and the data box. Press the period key again to disable 
both. 
 
 
Both the temporary and permanent versions of the crosshair can be activated by the Drawing 
Tools menu as well. Select the Cross option within the Drawing Tools menu to initiate the 
crosshair with data box; select the Plain option within the Drawing Tools menu to activate the 
crosshair with no data box. 
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INDICATORS IN TC2000 
 
 

Adding Plots to a Chart 
There are several ways to add a plots to a Chart in TC2000 v12.4. Each is discussed below. 

 
Select the Indicators section of the Library button located on the Main 
Toolbar.  Either manually locate the plot of interest using the scrolling ticker 
located along the right edge of the indicator list, or type to search for a plot of 
interest by keyword. Once a selection is made follow on-screen prompts to 
assign the plot to the Chart in the desired pane. 

 
As an alternative to the Indicators button on the Main Toolbar, select the Add 
Plot Icon to open a menu of all library plots including any indicators you have created 
and saved. You may type within the Search field at any time to limit the 
list based on keyword.  To make a selection from the menu of available 
items, select the desired item from the list to add it to the active Chart. 
Alternatively, right click anywhere on the chart and choose the Add New 
Plot to Chart option. 
 
Note that if the selection made is a child plot - meaning 
its calculation is based on the value of some other plot 
that needs to be assigned - you will be prompted to 
assign the parent plot from a list of all other indicators 
currently included on the active Chart. 

 
As an alternative to using the Add Plot button, try hitting the forward slash key / on the keyboard to 
initiate a search dialog. Type the name of the plot of interest, and once located within the search results 
list displayed, select it with the mouse or navigate to it with the arrow keys on the keyboard and make the 
desired selection.  The plot will be added to the Chart as it been added by the Add Plot button. All system 
plots are available in this way. 

 
Plots added using the Add Indicator button as described are added to 
new individual panes by default. It is possible to add a plot to a pane that 
already exists and that contains another indicator or plot. To add a plot 
to an existing pane, left-click one of the plots within the existing pane, 
and choose Add Plot Here... from the menu that appears.  Either 
manually locate the plot of interest using the scroll bar along the right 
edge of the dialog, or search by keyword within the Search field.  The plot 
selected will be added to the existing pane. 

 
A scale for the added plot is made visible within the pane that now contains 
two or more plots. Use the right-facing arrow located in the lower right 
corner of the Value Scale area to toggle through scale visibility modes. View 
scales for one or all indicators within the pane. 
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Plots that reside in their own panes may be re-located in one of 
several ways. They may either be repositioned relative to 
another pane (moved above or below), overlaid with another 
existing pane, or pinned to the side for later review. 

 
Use the Move button located to the left of every plot to 
initiate the on-screen prompts that allow the selection of any 
of the described movement options. 

 
Select any of the directional arrows displayed to move the 
selected plot or pane above or below an existing pane; select 
the Overlay option displayed on other existing panes to assign 
both plots to the same pane; or choose Pin to hide the 
contents of the selected pane, leaving only a named tab 
visible that can later be selected to view the pane's contents 
once more. 
 
 
 
 
Plots available for display in chart panes are:   
 

• Technical indicators—over 70 modern technical indicators 
• Historical Fundamentals—70+ fundamentals with up to 25 years of historical data 
• Industries—Morningstar Sector and Industry breakdowns 
• Indexes—Over 330 different US Market Indexes 
• T2 Market Indicators—25+ Market Indicators (market internals and breadth indicators) 
• ETFs—1500+ Exchange Traded Funds 
• 4x (Forex)--Over 55 Foreign Currency Pairs 
• Price Charts Other Symbols—plot any other symbol as a separate price plot on the same chart 
• Custom Personal Criteria Formula (PCF) Indicators—custom formula based indicators 

 
 

All data streams in real-time according to your level of service.  
• Gold: streaming 15-minute delay (plus BATS real-time data) 
• Platinum: streaming, full market real-time. 
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Managing Plots on a Chart 
Once there is a plot in a chart pane of a Chart, its name is made visible within the legend of the pane where it 
resides. To manage the indicator, click the name of the indicator and make a selection from the menu provided. 
From a plot menu, you may do the following functions: 
 

Edit: Assign plot characteristics like Plot Style, Plot Color, Period, Line Style, 
Line Width, Plot Opacity, and optional personalized Legend Label. 
Change Data Source: Change the source from which the plot is calculated. 
Add Plot Here: Select and add a child indicator or other plot to the pane 
where the selected indicator resides. 
Create Scan Condition: Use dialog provided to set up behavioral criteria 
required for selected plot. Use the Condition created to save for later use 
or to Scan/Sort a chosen WatchList immediately. 
Sort By: Apply related plot values to a WatchList as a sort column. 
Set Alert: Describe behavioral criteria for the plot selected. The behavior 
described will be monitored for the current Chart and alerts will be 
delivered based on current notification settings. 
Add Column to WatchList: Follow prompts to select location for plot’s 
column data to be added to a WatchList of choice. 
Scaling: Assign Scaling Method, including Auto (default), pre-configured 
options, or customize the selected plot’s scale. Also assign Grid Line 
settings based on Logarithmic, Arithmetic, and Line # options. 
Horizontal Lines: Select to either edit existing or add new horizontal plot guides for the plot selected. 
Save this indicator: Save an indicator or plot to the library. Saved plots retain characteristics assigned using the Edit 
functions and if viewed subsequent to saving appear as they did the last time they were saved. Personally saved 
plots are available to be added to any Chart using one of the standard plot addition methods. 
Remove: Delete the selected plot from the Chart. 
   

Viewing Historical Charts 
It is possible to view up to 500 bars of historical data for any plot on any 
Chart. Whether you are viewing a Daily, Weekly, 5-Minute, or 1-Minute 
Chart, 500 bars of Price and indicator data are available to view. To assign a 
zoom level for the Chart and ultimately control the amount of historical 
information in view and the period of data isolated to view use the Zoom & 
Pan slider at the bottom of the chart. 

 
This slider gives you control over how much historical information is displayed 
on a Chart at a given time. To zoom out, and view more historical data values 
for your indicators, grab the left-most handle of the slider and drag it to the left, 
enlarging the size of the slider. Using your mouse scroll wheel is a shortcut to 
zoom in or out on Chart data. To change the historical period in view, grab the 
entire slider, and drag it to the left or right. 
 
The Timespan buttons at the bottom of the chart show you chart 
data for exactly that period of time. (e.g. 5Y = 5 years; 3M=3 months) 
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  CHART TOOLBAR 
 

Each Chart displays a default toolbar, which contains basic buttons that can be used to accomplish several 
standard Charting-related tasks. Default toolbar items include the following: 

 
New Chart Drop-Down  
Add Plot Button (Plus sign) 
Ticker Symbol 
Open Component WatchList  
Industry information icon 
Timeframe Drop-down 
Add to Personal WatchList Button  
Edit Chart Settings Button  
Edit Indicators Button 
Create Alert or Reminder Button  
Write a Note Button 
Sector and Industry Memberships 

 
This Chart toolbar can be made visible or invisible and can be edited to include other selected data fields or 
function buttons. To access and edit the toolbar or to change visibility settings, right-click within the 
background space to the right of the Chart toolbar, and select Edit Toolbar when prompted. 

 
 
 
 
 

Control visibility settings for the default toolbar using the checkmark located to the left of the listed toolbar 
items. Right-click any of the existing toolbar fields to edit the field's properties. Move the relative position of 
each field, delete if desired, or change label and font characteristics for the field. 

 
To add a field to the default toolbar, select the Add Field button located on the far-right end of the existing 
toolbar fields (orange +). Either manually locate the desired field using the scroll bar along the right edge of the 
Edit Field dialog, or type to search by keyword. Once the desired field is located, select it using the mouse, and 
the field will be added to the existing toolbar. 

 
It is possible to create additional toolbars, which can be customized to contain only the information and 
function buttons you need access to at the top of your Charts. 

 
If you would like to create a customized toolbar or add a new line of information to an existing visible toolbar, 
select the Add Row button, then select the Add Field button within the new toolbar line that is created. 

 
The toolbars selected are universal and will be visible on every Chart opened. 
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  SAVING AND RETRIEVING A CHART 
 

One of the tool window controls available to every Chart is the 
Save button. Select the blue disk icon located in the upper right 
corner of any Chart window, and select Save Chart from the 
menu provided. 

 
Provide a name when prompted, and select Save. All Chart 
characteristics are saved with a Chart. When a previously saved 
Chart is opened, it appears as it did the last time it was saved. 

 
 
 
 
 
 
 

To open a previously saved Chart, select the Charts button located 
on the Main Toolbar to view the Charts dialog. You may either 
manually locate a Chart of interest using the scroll bar along the 
right edge of the dialog, use the My Charts and Pre-Built Charts sub-
category menus, or you can type to search for a desired Chart by 
keyword. 

 
Charts opened in this way are added to Layout Tabs as undocked 
windows and can be moved, docked or floated as separate 
windows using the methods described in the Customizing a Layout 
Tab section of the user guide. 

 
An existing Chart within a Layout Tab can be changed to display the 
content of a previously saved Chart. In the upper-left corner of 
every Chart is a new chart drop-down (the name of your current 
Chart Template will be present as the current drop down 
selection). Select the drop-down to view a list of available 
previously saved and Pre-Built Charts. Select one of the items to 
open view its content within the exiting window. 
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WatchLists 
 
 

  WHAT IS A WATCHLIST? 
 

A WatchList is any group of tickers that is displayed as a list inside a WatchList window.  Some WatchLists are 
created and maintained for you and are instantly available by the WatchList drop-down menu. These lists 
include Indices, Industries, Exchange Traded Funds, ETF components, Forex, Pink Sheets, Mutual Funds, etc. 

 
When a new WatchList window is generated, by default it displays a 
list of the Nasdaq 100 stocks. A different default WatchList can be 
assigned, if desired. Choose the Change List/Scan Properties icon in 
the upper right corner of a selected WatchList window. Then choose 
Set WatchList as System Default from the menu provided. 

 

Selecting a WatchList 
 

To view the contents of a specific WatchList, click the WatchList 
drop-down, and either locate the desired list name manually using the scroll bar along the right edge of 
the menu, or begin typing to limit the list based on keyword. You may also use the sub-category menus 
provided to view a list of only a certain type of WatchList. 

 

Note that selecting a WatchList from the 
WatchList button on the Main Menu 
generates the new list in a floating 
window that can be left floating or 
docked or tabbed with another window 
or group of windows within the Layout 
Tab. Selecting a WatchList from the 
WatchList drop-down of an existing 
WatchList window changes the items 
displayed within the existing window. 

 

WatchList Menu Categories 
Categories of WatchList type include All, Main, Personal, Component, Industry, ETF, and Clubs. 

 

All: Displays a list of all system WatchLists, organized alphabetically by sub-category. 
Main: Displays a list of all of the most commonly accessed WatchLists, organized alphabetically. 
EasyScans: Displays a list of all personally created and saved EasyScans as well as a list of Pre-Built 
EasyScans provided by default. 
Personal: Displays a list of only those lists created by the user. Personal WatchLists can be opened or 
deleted from this location. 
Component: Displays major index component lists. 
Industry: Displays a list of Main and Sub-Industry groups, organized alphabetically first by Main Industry, 
then by Sub-Industry. 
ETF: Displays Exchange Traded Fund component lists, organized alphabetically. 
Clubs: Displays WatchLists published to user-enrolled clubs, organized by club name. 
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 WATCHLISTS BUTTON (MAIN TOOLBAR) 
 

The WatchLists button located on the Main Toolbar provides access to a library of any and all system 
WatchLists, including those that have been created and saved personally as well as those that were created and 
added to the library by TC2000. 

 
Select the WatchLists button to view the WatchList dialog.  
You may either manually locate a WatchList of interest using 
the scroll bar along the right edge of the dialog, use the sub- 
category menus, or you can type to search for a desired 
WatchList by keyword. 

 
To view only the WatchLists within one of the sub-category 
menus, select the radio button associated with the desired 
sub-category. 

 
Personally created WatchLists will automatically be saved and 
will be stored in the Personal sub-category within the 
WatchLists button of the Main Toolbar. 

 
Note that in addition to opening existing WatchLists from the WatchLists button, it is also possible to create a 
new WatchList from this location. Select the Create New Personal WatchList button, provide a name for the 
list when prompted, then either select the Add Symbols button displayed within the blank personal WatchList 
or right-click in the background area of the blank list and select Add Symbols to List from the menu provided. 
Follow on-screen prompts to add any desired tickers to the WatchList. 

 
All WatchLists opened from the WatchLists button of the Main Toolbar open as undocked windows that 
may either be left undocked, moved or floated as a separate window according to the directions discussed 
in the Customizing a Layout Tab section of the user guide. 

  SORTING A WATCHLIST 
 

 
WatchLists can be sorted by symbol, indicator value, or Condition. Any of these sorts can be performed in 
ascending or descending order. 

 
 

Sorting by Symbol 
Left-click the Symbol column header located in the WatchList header area. The 
initial sort order will be ascending, from A to Z. To change the sort order to 
descending, left-click the Symbol column header once more. 

 
Sorting by Plot Value 
Any displayed plot can be used to create a sort column within a WatchList. A sort column created in this way 
will order the items in the WatchList by the current value of the plot used to create the column. Click any 
displayed plot name in the Chart legend and choose Add column to WatchList from the menu provided. Follow 
the on-screen prompts to assign plot column positioning within a WatchList of your choice. 
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You are given the choice to either Add Column, in which case the numerical 
value of the plot selected will be displayed next to each item in the 
WatchList for which the information applies - or - to Add Column & Sort, in 
which case the column is still created as above, but the list will be ordered 
by the values in the new column. 

 
Timeframes, column header labels, and relative positioning or columns can 
all be adjusted using a menu accessed by right-clicking an existing column 
header. 

 
When a plot is selected from the Add Plot button located on the Main 
Toolbar, on-screen prompts provide the ability to add indicator values to 
any visible WatchList as a column as well. The Add Column and Add Column 
& Sort options discussed above are both available. 

 
 

Sorting by a Condition 
Any Condition may be used to sort a WatchList, identifying the items in 
the list that pass the Condition with a colored check mark. Click any 
indicator on a Chart and select Create Scan Condition to set up a 
behavioral criteria for the plot selected. The Condition created 
may be saved if you wish.  Choose a scanning method; then follow 
on-screen prompts to select the WatchList to which a sortable 
Condition column should be added. 

 
 

On-screen prompts provide a choice to either Add Column, in 
which case a check mark is placed next to any item within the 
WatchList for which the Condition is true - or - to Add Column & 
Sort, in which case the items within the newly added column that 
have checkmarks are sent to the top of the Condition column. 
The position of Condition columns can be adjusted once the 
column is present in a WatchList.  Right-click any Condition 
column header, to edit, move, save, or delete the column. 

 
 
 
 

It is also possible to use a previously saved Condition to create a 
Condition column within a WatchList. This can be accomplished 
in one of two ways. Either select the Add Column button located 
to the right of any column headers within the WatchList of interest 
and locate the Condition within the My Conditions sub-category, 
or select the Conditions section of the Library button located on 
the Main Toolbar, and select a previously saved Condition from 
the menu provided.  Follow on-screen prompts to assign a suitable 
position for the Condition column. 
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  CREATING AND DELETING A WATCHLIST 
 

To create a personal WatchList, select the WatchLists button from the Main Toolbar, and choose Create New 
Personal WatchList from the Quick Lists section of the All sub-category tab. 

 
Provide a name for the list when prompted, then 
either select the Add Symbols button displayed 
within the blank personal WatchList or right-click in 
the background area of the blank list and select Add 
Symbols to List from the menu provided. Follow on- 
screen prompts to add any desired tickers to the 
WatchList. Remember than when adding symbols 
to a list, you can enter partial or complete tickers 
and company names to search for the desired ticker. 

 
Personally created WatchLists will automatically be 
saved and will be stored in the Personal sub- 
category within the WatchLists button of the Main 
Toolbar. 

 
Personal WatchLists can be deleted using the [X] icon 
displayed next to each personal WatchList within the 
Personal sub-category of the WatchList drop-down. 

 
When a personal WatchList is active within a WatchList window, an 
Add Symbol button is visible. A rename option is available by clicking 
on the Properties icon. Choose the Rename option to rename the 
WatchList. 

 
 
 WATCHLIST AESTHETICS 

 
 

To assign WatchList aesthetics, right-click in the blank background space of any 
WatchList, and select Properties from the menu provided. Assign Background 
Color, Grid Color, and Font Size characteristics as desired. Use the Apply to... 
button to apply these changes to other WatchLists. Select either All WatchLists in 
this Layout Tab, All WatchLists, or assign the settings to be the Default for new 
Windows. 
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                                                                              RELATED ITEMS WATCHLIST 
 

The Related Items WatchList shows any Indexes 
and Exchange Traded Funds the current symbol is a 
part of. You also have immediate access to lists of 
all the stocks that share the same Sector or 
Industry category. Plus, if the current symbol is an 
Index or an ETF, you’ll find a list of its components 
or holdings. 
 
The Related Items window paints an instant picture of a 
symbol’s position within the market and relationship to other 
symbols. There are a couple of ways to open a Related Items 
WatchList. Click the WatchLists button on the Main Toolbar, 
and choose any of the blue WatchLists within the QuickLists 
section. Blue WatchLists include Member of, Industry, Sector, 
and Components.  
 
Alternatively, click the Industry Information 
button on any chart, and choose Open 
Sector/Industry WatchList. 
 

 

  CONTROLLING THE ACTIVE SYMBOL 
 

The Active Symbol is the symbol for which information is displayed on a particular Chart, or in the case of a 
WatchList, the Active Symbol is the currently selected symbol within the list. 

 
Click any item within a WatchList to display its information on current "listening" Charts. 

 
Hit the spacebar to navigate sequentially through the list of WatchList items; use the backspace key to navigate 
backward and sequentially through the list of WatchList items. 
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EasyScans 
 
 

  WHAT IS AN EASYSCAN AND HOW DOES IT WORK? 
 

What is an EasyScan? 
A scan is composed of a Condition or group of Conditions. To scan is to limit a WatchList to only those items 
that meet the behavior criteria standards specified by any Conditions 
listed within the scan.  Scans can be initiated based on indicators 
directly from a Chart, or they can be added to a WatchList by the 
EasyScans button, located on the Main Toolbar. 

 
Note: the term Scan should be contrasted with the word Sort. Make 
sure you understand the difference between the two. Whereas a scan 
limits the items displayed in a WatchList to only those that meet its 
Condition(s), to sort is to arrange (rank) the items within a WatchList 
by some value or Condition. Sorting a WatchList never limits its 
contents - the contents are simply placed in a specific sort order. 

 
How Does it Work? 
Selected Conditions are applied to WatchLists as scans. Multiple Conditions may be created and applied to 
the same WatchList in an additive way, which means that scans can consist of only one Condition or might 
consist of many Conditions.  All Conditions listed for a scan must be true in order for stock or other item that 
passes the scan to be listed as one of the results of the scan. Conditions can be created from the chart 
indicators, pulled from the TC2000 pre-built libraries or written using Personal Criteria Formulas. 

 
To view the Conditions associated with any active 
scan, select the Edit tab within the scanning 
WatchList window. To view the results of any 
active scan, select the Scan tab within the scanning 
WatchList window. The results listed will remain 
constant unless refreshed. To refresh the results of 
a scan, use the Refresh button located on the 
Results tab. Platinum users can select the 
Streaming tab, which constantly displays an actively 
refreshed list of items passing all related scan 
Conditions. 

 
The number of stocks returned as a result of the scan can be 
seen in the bottom left corner of the WatchList that was 
scanned. 

 
To save an EasyScan once it has been created, use either the Disk icon located in the upper-
right corner of the scanning window. 

 
Once a scan is active, if the WatchList visible within a given WatchList window is changed, the scan will 
become inactive. 
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  EASYSCANS BUTTON (MAIN TOOLBAR) 
 

The EasyScans button located on the Main Toolbar provides access to a library of any and all system scans, 
including those that have been created and saved personally as well as those that were created and added to 
the library by TC2000. 

 
Select the EasyScans button to view the Open Scan dialog.  You may either 
manually locate a scan of interest using the scroll bar along the right edge of 
the dialog, use the sub-category menus, or you can type to search for a 
desired scan by keyword. 

 
To expand one of the sub-category menus, select the plus sign located next 
to the sub-category name of interest. To collapse the sub-category menu, 
select the minus sign located next to the sub-category name of interest. 

 
Scans that you create and save will be stored in the EasyScans sub-category 
within the EasyScans button of the Main Toolbar. Scans created and added by TC2000 will be located within the 
Pre-Built Scans sub-category of the EasyScans button. Any of the EasyScans scans can be deleted from this 
location. 

 
Note that in addition to opening personally saved and Pre-Built scans from the EasyScans button, it is also 
possible to create a new scan as well. Select the Create New EasyScan button to open the Edit Scan dialog, 
where Conditions may be added, a name may be provided, and the scan can be saved, if desired. 

 
 
 
 

INITIATING AN EASYSCAN FROM A CHART 
 

To create a scan based on a plot Condition from a Chart, click the plot name 
in the legend of its pane, and choose Create Scan Condition from the drop 
down menu. Use the dialog provided to assign conditional parameters.  
When finished, select Add to an existing WatchList to scan an existing 
WatchList in the Layout Tab or Scan or Scan in new window to open the 
EasyScan in a new undocked window. 

 
If you would like to add another Condition to a scan that is already 
active within a WatchList, choose Add to an existing WatchList or Scan 
after defining the parameters of the Condition. Then choose to add 
the Condition to the already active scan. 

 
This adds the second Condition to the original scan, and WatchList 
items that are returned as a result of the scan will be those that 
passed the original Condition and the newly added Condition. 
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Chart Plots 
 
 

  WHAT IS A CHART PLOT? 
 

A chart plot is a graphical plot displayed within any pane of a chart window. Plot values are displayed along the 
x (time) axis in increments determined by the Timeframe assigned to the Plot’s Chart; values are 
displayed along the y (value) axis as is determined by scale settings. There are many technical 
indicators available for plotting by either the Add Plot button located on the default Chart Toolbar, or 
by the Indicators section of the Library button located on the Main Toolbar. However, there are also a wide 
variety of other data that can be plotted on any chart. 

 
See the Adding Indicators to a Chart section of the user guide for more information about how to find an 
indicator of interest and add it to a chosen Chart pane. 

 
 
 
 

  INDICATORS BUTTON (MAIN TOOLBAR) 
 

The Indicators section of the Library button located on the Main Toolbar 
provides access to a library of any and all system plots, including those 
that have been created and saved personally as well as those that were 
created and added to the library by TC2000. 

 
Select the Indicators menu item to view the Select Plot dialog. You may 
either manually locate a plot of interest using the scroll bar along the right 
edge of the dialog, use the sub-category menus, or you can type to search 
for a desired indicator by keyword. 

 
There are several sub-categories of plots within the Select Plot dialog. 
 
 
 
 
 
 
 
 
 
 
 
Indicators - contains standard technical indicators made available for addition to Charts. System Indicators 
include Moving Averages, Bollinger Bands, Stochastics, etc. These plots can be used for sort/scan conditions.  
Fundamentals – financial and data sheet information that can be plotted historically on the chart for up to 25 
years. Fundamentals include: Earnings, Sales, Book Value, PEG Ratio, Capitalization, etc. These plots can be 
used for sort/scan conditions.  
Industries – charts of the major sectors and industries are composites of price and volume for all the stocks that 
make up each industry. These charts stream in real-time for easy stock to industry comparisons in any timeframe. 
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Indexes - charts of the major indexes are composites of price and volume for all the stocks that make up each index. 
These charts stream in real-time for easy stock to index comparisons in any timeframe. 
T2s - charts of the market breadth indicators characterize the big picture and broad internal characteristics of the 
market on which they are based. These charts stream in real-time. 
ETFs - charts of the ETFs (Exchange Traded Funds) are representative of all the stocks that make their holdings. 
These charts stream in real-time for easy stock to ETF comparisons in any timeframe. 
Formulas – Personal Criteria Formula written to return a value (non-Boolean) form can be plotted as technical 
indicators on the chart. These plots can be used for sort/scan conditions. 
4x (Forex) – over 50 foreign currency pairs are available in their own WatchList. These Forex charts stream in 
real-time to give current information on the relationship between foreign market currencies. 
Symbols - add as many separate Price graphs for as many symbols as desired to any single chart. All share the 
same zoom and can be overlaid for easy performance comparisons. 
 
To access one of the sub-category menus, select the appropriate tab located across the top of the Select Plot 
dialog.  

 
User-created indicators/plots that are saved will be stored in either the Indicators tab or the Formula tab, 
depending upon the method that was used to create them. Indicators created and added by TC2000 will be 
located within the Indicators tab. All other plots will fall under their appropriate tab designation Any personal 
indicator or formula can be either edited or deleted from this location. Use the X to the right of any personal 
indicator or formula to delete. Use the Edit option next to the formula name to edit any personal formula. 

 
Note that in addition to opening personally saved and Pre-Built 
plot or indicator from the Indicators 
button, it is also possible to create a 
new indicator formula as well. Select 
the Write Indicator Formula button to 
open the Edit PCF dialog, where a 
mathematical formula describing an 
indicator can be entered for use 
elsewhere in TC2000.  
 
Alternately, use the New button on the main Toolbar and choose 
Indicator (PCF) Formula to open the Edit PCF dialog.  

 
Formula-based indicators can be plotted, used to scan, or can be used to 
display column values for WatchLists - just like any other indicator. 
 

           CHANGE INDICATOR DATA SOURCE 
 

The data source on which an indicator is calculated can now be 
changed. Left-click on the Indicator name in the legend of its 
pane. Select Change Data Source option. A list of visible 
indicators upon which that indicator can be based now 
appears. Click on the desired source and the indicator is now 
based on that source of data. 
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Conditions 
 
 

  WHAT IS A CONDITION? 
 

A Condition is a user-defined entity that describes a specific behavior for an individual indicator or the 
interaction between multiple indicators. All indicators, including Price, Volume, or any other technical or 
fundamental piece of data available within TC2000 can be used to create conditions. A Condition is used to 
identify stocks that are actively exhibiting the behavior defined by either including the Condition in a scan, 
which can include one or more Conditions - or by sorting a WatchList by the Condition. Conditions are 
created by a chart plot, a selection from the TC2000 pre-built condition library or written by a Condition 
Formula. 

 
Conditions created with plots on a Chart are initiated as follows: 

1. Click the name of the indicator of interest. ( Note that the indicator 
must be visible on a Chart, and the name of the indicator in the Chart's 
pane legend should be selected.) 

2. Choose Create Scan Condition from the menu displayed as a result 
of Step 1. 

3. Use the drop-downs provided within the Create Scan Condition 
dialog to set parameters for the Condition. These parameters will 
ultimately describe the behavior of interest.  Behavioral 
parameters as well as Timeframe will be assigned within this 
dialog. 

4. Take note of the default color assigned to the Condition (or change 
the color for the Condition by the Color drop-down, if desired). 
You may also choose to save the Condition at this point, in which 
case, the Condition will be available for use at any time in the 
future by the Conditions button located on the Main Toolbar. 

5. Select either the Add to an existing WatchList or Scan button or the 
Scan in new Window button, and follow on-screen prompts 
to implement the Condition as either a scan or sort criteria. 

 
Conditions created by Condition Formula are initiated as follows: 

1. Select the New Button on the Main Toolbar, and choose Condition 
(PCF) Formula 

2. Within the Edit PCF dialog displayed, enter a name for the Condition, select 
a Timeframe for the Condition, and enter a Boolean (True or False) 
mathematical formula that describes the intended condition behavior. 

3. You may choose to test the formula written using the Test Formula 
button, if desired. 

4. Select OK. 
5. The Condition created has been saved to the My Conditions (Formulas) sub-

category of the Conditions menu, which can be accessed by the Conditions 
button located on the Main Toolbar. 

 
Note, there are some basic rules for writing Condition Formulas as Personal Criteria Formulas. Refer to the 
PCF Appendix at the end of this guide for more information. 
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  CONDITIONS BUTTON (MAIN TOOLBAR) 
 

The Conditions section of the Library button located on the Main Toolbar provides access to a library of any and 
all system Conditions, including those that have been created and saved personally as well as those that were 
created and added to the library by TC2000. 

 
Select the Conditions option to view the Conditions dialog.  
You may either manually locate a Condition of interest using 
the scroll bar along the right edge of the dialog, use the sub-
category menus, or you can type to search for a desired 
Condition by keyword. 

 
 
 

There are several sub-categories of Condition within the 
Conditions dialog. 

 
 

My Conditions - includes those Conditions that were originally 
created from an Indicator on a Chart and were saved by the 
user. 

 
My Conditions (Formulas) - includes those Conditions 
that were originally created and saved by a Condition 
Formula (a Personal Criteria Formula mathematically 
defining a behavior of interest). 

 
Pre-Built Conditions - includes Conditions that were 
either created by or written by TC2000 and were 
uploaded for your use. Pre-Built Conditions can change 
at any time. 

 
 
 

To expand one of the sub-category menus, select the plus sign located next to the sub-category name of interest. 
To collapse the sub-category menu, select the minus sign located next to the sub-category name of interest. 
Conditions created and added by TC2000 will be located within the Pre-Built Conditions sub-category of the 
Conditions button. 

 
Conditions that you create and save will be stored in 
either the My Conditions sub-category or the My 
Conditions (Formulas) sub-category, depending upon 
the method that was used to create them.  
 
Any of the My Conditions can be deleted from this 
location; any of the My Conditions (Formulas) 
Conditions can be either edited or deleted from this 
location. 
 
A sort or scan can be initiated from any conditions using the lightning bolt icon to the right of the condition name. 
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Financials & Stats 
 
 

  WHAT ARE FINANCIALS & STATS AND HOW DO I USE THEM? 
 

Financials and Stats are fundamental data reported by public companies.  Financials and Stats data are 
provided to TC2000 by Morningstar; the latest available reported value for each data field is updated and 
made available to users on Saturday of each week. 
 
Sorting by Fundamentals 

 
These data can be used either as Sort or Scan criteria. To use Financials and Stats data as part of a sort or scan, 
follow these steps: 

 
1. Select the Financials and Stats section of the 

Library button located on the Main Toolbar. 
2. Either locate the data field of interest manually by 

scrolling through the list, or type within the Search 
field to locate the field of interest. 

3. Select the desired piece of data. 
 

Follow the on-screen prompts to implement the selected 
data field as either a sort or a scan. 

 
Remember that Financials can be used to scan or sort an 
existing WatchList window and its content or can be used 
to scan or sort in a new window, in which case a new floating WatchList window will be generated containing 
the scan or sort (depending on which was selected). 

 
If you choose to add the Financial data as a sort column, the column added to 
the WatchList chosen will be populated with the latest available reported value 
for the data field chosen. Note that there will be a Market Ranking gage 
located beneath each WatchList item's reported value.  This ranking represents 
where that items value ranks relative to all of the other reporting companies' 
values. 

 
If the Ranking gauge appears to be completely or nearly completely opaque, 
the associated company has a very high value for the selected data field relative 
to all of the other reporting companies in the market. 

 
If the Ranking gauge appears to be completely or nearly transparent, the 
associated company has a very low value for the selected data field relative to 
all of the other reporting companies in the market. 

 
If you choose to add the Financial data as a scan, an Edit Condition dialog will 
appear, in which you can assign behavioral parameters for the piece of data. Once the parameters have been 
assigned, select OK. Within the scanned WatchList, only the items that meet the Conditions defined will remain. 
See the EasyScans section of this guide for more information on the process of scanning. 
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                                                     PLOTTING HISTORICAL FUNDAMENTALS 
 

Financials and Stats can now be plotted on any chart as a separate pane or overlaid in any other plot pane.  
 
To plot a historical fundamental, use any of the plot methods listed 
above in the Add Plots to Chart section of the user guide to open the 
Select Plot menu.  
 
From the Select Plot dialog, chose the Fundamentals tab. You may 
either manually locate a plot of interest using the scroll bar along the 
right edge of the dialog, use the sub-category menus, or you can type to 
search for a desired indicator by keyword. 
 
This plots the selected fundamental historically and in sync 
with the price chart on which is it plotted.  
 
This plot can be used to create a WatchList sort column, 
EasyScan conditions or overlaid on other plots as described 
previously in the User Guide. 
 
Financials & Stats available are: 
 
Accu. Depreciation & Depletion  
Asset Turnover 
Beta  
Capitalization  
Common Stock Equity  
Common stock at par value 
Capital srpls or addl paid-in cap 
Retained earnings/earned srpls  
Common Stock Equity  
Cost of Sales  
Current Book Value per Share 
Debt to Equity Ratio  
Diluted EPS from Total 
Operations 
Dividend Growth Rate 5-Yr  
Dividend Yield  
Earnings 1-Year  
Earnings as Percent of Sales 1Yr  
Earnings Growth Rate 5 Year 
EPS Latest Quarter 
EPS Percent Change 2nd Qtr Bk 
EPS Percent Change 3rd Qtr Bk 
EPS Percent Change 4th Qtr Bk 
EPS Percent Change Latest Qtr  

EPS Percent Change Latest Year 
Gross Fixed Assets 
Gross Margin  
Gross Operating Profit  
High Price Divided by Earnings 
Ratio  
Latest Float  
Latest Net Profit Margin 
Latest Short Interest Ratio 
Latest Total Net Income  
Long Term Debt Divided by 
Total Capital  
Long Term Debt to Equity Ratio  
Low Price Divided by Earnings 
Ratio  
Net Fixed Assets  
Net Profit Margin (Post Tax)  
Operating Cash Flow 1-Year  
Operating Income before 
Depreciations-EBITDA 
P/E Ratio 
P/E Ratio vs 5 Year Average P/E  
PEG Ratio 
Percent Change Revenue 1-Yr  

Percent Change Rev Last Qtr  
Percent Shares Held by Insiders  
Percent Shares Held by Institu. 
Pre Tax Income-EBT 
Price Growth Rate 1-Year 
Price Growth Rate 2-Year 
Price Growth Rate 3-Year 
Price Growth Rate 5-Year 
Price to Sales Ratio 
Price Volatility 
Relative Strength 1-Year vs SPX 
Return on Assets (ROA) 
Return on Equity (ROE) 
Revenue Grth Rate Last 4 Qtrs 
Sales 1-Year 
Sales Growth Rate 5-Year  
Short Term Debt 
Total Assets 
Total Current Assets 
Total Income before Interest 
Expenses-EBIT 
Total Volume Last 13 Weeks 
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Columns 
 
 

  WHAT ARE COLUMNS AND HOW DO THEY WORK? 
 
 

Columns contain either numerical or Condition 
information for listed items within a WatchList. The TC 
Classic Layout Tab contains a WatchList with the 
following columns: Net Change, % Change, Price, 
Volume Buzz, and Volume. 

 
Columns can be generated by an indicator from a Chart, the Add Column 
button located within every WatchList window, the Properties button located 
within every WatchList window, or the Columns section of the Library button 
located on the Main Toolbar. 

 
Creating a Column from an Indicator on a Chart 
To create a column of plot values for one of the plots on a Chart, click the name 
of the indicator on the Chart's pane legend. Select Add 
Column to WatchList from the menu displayed. Then follow 
on-screen prompts to assign the column type to be created.  
The column may either be 

 

• added but not sorted 
• added and sorted 
• added as a sort in an undocked window. 

 

Choose Add Column from the on-screen prompts to add a 
column of indicator data but not sort the items in the 
WatchList by column values.  Choose Add Column &Sort from the 
on-screen prompts to add a column of indicator data and sort the 
items in the WatchList by the populated values. Choose Sort in New 
Window to generate a new floating WatchList window containing 
the desired column with WatchList items sorted. 

 

Creating a Column using the Add Column Button 
In the upper-right corner of every WatchList is an Add Column 
button. You may manually search for the column of interest within 
the Add Column dialog that appears when the Add Column button is 
selected. Scroll through the columns listed until the desired column 
is located; then select its name and follow on-screen prompts to 
assign the column type to be created. 

 
There are several sub-categories of columns, which may originally be minimized. To expand one of the sub- 
category menus, select the plus sign located next to the sub-category name of interest. To collapse the sub- 
category menu, select the minus sign located next to the sub-category name of interest. 
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Sub-categories include My Saved Columns, Basic Columns, WatchList Tracking, Fundamentals, My Conditions, 
My Indicators, and Pre-Built Columns. 

 
As an alternative, search for the column of interest by typing the name of the desired column into the Search 
field. 

 
My Saved Columns and Basic Columns are worth mentioning in greater detail here.  Items belonging to the 
other sub-category menus can be read about in the corresponding user guide section. 

 
My Saved Columns - Contains all of the columns or groups of columns that have been added by a user and 
saved. When several columns are visible within a WatchList, it is possible to save the columns as group.  In 
the upper-right corner of every WatchList window is a Save button. Select the Save button, and choose 
Save Columns to save the current columns as a group. This saved group will be available from the My 
Saved Columns sub-category of the Add Column button going forward. 

 
Basic Columns - Contains often-needed column information, including the following: Symbol Column, 
Company Name, Note Date, Flag Column, Price, Todays Volume, Todays %, Todays Net, Today's Volume 
Buzz, Ask Price, Bid Price, Exchange, Optionable Stocks, Split Date, Industry, and Sub-Industry. 

 
 
 

Adding Columns from the Library Button 
The Columns section of the Library button located on the Main Toolbar provides access to a library of all saved 
and pre-built columns, including those that have been created and saved personally as well as those that were 
created and added to the library by TC2000. 

 
Select the Columns button to view the Add Columns to 
Layout Tab dialog. You may either manually locate a column 
of interest using the scroll bar along the right edge of the 
dialog, use the sub-category menus, or you can type to 
search for a desired column by keyword. 

 
There are two sub-categories of column within the dialog. 

 
My Columns - contains columns and column sets that 
were previously added to a WatchList and saved. 
Saved groups of columns will be marked with the label 
Column Set. 

 
Pre-Built Columns - contains columns or groups of 
columns that were created and are maintained by 
TC2000. Groups of columns will be marked with the 
label template. Pre-Built Columns can change at any 
time. 

 
To expand one of the sub-category menus, select the plus sign located next to the sub-category name of 
interest. To collapse the sub-category menu, select the minus sign located next to the sub-category name of 
interest. 
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Once the column or column set of interest have been located, select its name 
then follow on-screen prompts to assign it to a WatchList window.  For 
individual columns selected, you'll assign them a position to the right or left of 
existing columns within a WatchList. 

 
For column sets selected, you'll choose a WatchList whose existing columns 
should be replaced. Columns and column sets that you create and save will be 
stored in the My Columns sub-category. Any of the My Columns can be 
deleted from this location. 

 
Columns created and added by TC2000 will be located within the Pre-Built Columns 
sub-category of the Columns button. 

 
Swapping Existing Columns for a Saved Column Set 
Existing columns within a WatchList window can easily be 
replaced with a different column set. Click the Properties 
button located adjacent to any WatchList drop- down and 
choose the Load Columns option. This opens a list of 
available column sets - both personally saved and pre-
built. The chosen column set will instantly replace the 
existing column set. 

 
Alternatively, you could view the Columns section of the 
Library button on the Main Toolbar to access a list of 
available individual columns and column sets. If you 
choose an individual column from the library, you'll assign 
it a position to the right or left of the existing columns 
within a WatchList. If you choose a column set from the 
library, you'll choose a WatchList whose columns 
should be replaced by the selected set. 

 
 

Assigning Default Column Sets for WatchLists 
Once added to a WatchList, a group of columns can be 
assigned as new default columns, so that any time a 
new WatchList window is generated, the default 
columns assigned will be visible.  To assign a new 
default group of columns, select the Properties button 
located in the upper-right corner of every WatchList 
window and choose the Save Columns option.  Choose 
Save as Default for: within the menu provided. Mark 
the check boxes next to any of the desired default 
targets, which include System WatchLists, EasyScans, 
Industry Group WatchLists, and Personal WatchLists. 
Select Save when finished. 
 
Edit Column Properties 
Edit the column properties by clicking the Properties button and choosing 
the Edit Columns option. Change the order of the columns, color options, 
etc. from the menu. 
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Drawing Tools 
 

A menu of Drawing Tools can be accessed by clicking the Drawing Tools icon (paint palette) at the 
top right of the chart. The keyboard shortcut Ctrl + T toggles the menu through the small icon, 
larger icon and no menu modes. When the Drawing Tools menu is visible, the Drawing Tools 
dialog is displayed, providing a menu of all available tools. The Drawing Tools include all of the 
following: 

 
Lines - Trend Line, Horizontal Line, Vertical Line Chart Text 
Fibonacci Tools - Arc, Retracement, Fan, Projections and Time Zone  
Andrew's Pitchfork 
Error Channels Gann Fans Quadrant Lines 
Regression Tools - Regression Line, Regression Channel, Raff Regression Channel, and Error Channel Speed Lines 
Tirone Levels 
Shapes - Ellipse, Rectangle, and Arrows. 

 
To activate any of these tools, select the desired tool from the Drawing Tools menu, then click 
within the Charting area to initiate the drawing. 

 
The Ctrl+Click command initiates the last drawing tool used. There is also a Repeat Mode check 
box located in the bottom left corner of the Drawing Tools menu. If selected, any drawing tool 
initiated will remain active until the Esc command is used to exit the drawing or another drawing 
from the list is selected. The Snap to option automatically attaches the end of your drawing to the 
closest component of the bar/candle (OHLC). 

 
Click any Chart drawing to edit or delete it from the Chart; all Chart drawings for a particular symbol 
may be managed by the Drawings button, located on the default Chart Toolbar. 

 
 

Drawing Tool Settings 
Right click on the chart to access the Drawings 
option located in the drop down menu to initiate 
the Manage drawings for… dialog. Within the 
dialog, it is possible to view a list of all drawings 
for a particular symbol with their details and 
manage the display settings. 

 
The Manage Drawings for… dialog includes 
the following options: 

• Delete all drawings on (symbol) – 
deletes all drawings from all drawing 
boards for the named symbol 

• Drawings individual drawings – click 
the x next to any drawing name to 
delete that single drawing 

• Location – at the right of each drawing’s 
description the location of that drawing is 
stated in red 

• Board #--shows the Drawing Board on which 
that particular drawing is located. 
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Drawing Boards 
Drawings can now be assigned to specific Drawing Boards, which act as layers that keep drawings of different 
types separate. The Drawing Boards tool is located at the bottom of the Drawing Tools menu. Click the Drawing 
Tools icon (paint palette) to open the drawing tools. Click the More button to expand the menu and get more 
information on the Drawing Boards. (Alternatively, use the Ctrl + T hotkey.) 
 
Any of the eight boards can be toggled on or off at any time for any chart using the 
tick boxes next to the board numbers. The highlighted board is the board on which 
any drawings made at that time will be placed. Click on any board to highlight it 
and drawings will be placed on that board. Check marks appear on any board 
whose drawings are visible (active). 
 
Ctrl-Click any board number within the Drawing Toolbar to make its drawings 
visible. Any, all or none of the boards can be visible at any time.  
 
Use the Scratch board for a particular chart template to jot thoughts and drawings 
that might not need to be available for use on any other templates. 
 
The middle column of the menu contains the number of drawings for that symbol 
on that board. Click the number to move the drawings to another board or delete 
all of the drawings for that symbol from that board. 
 
The right-hand column contains the number of symbols that have drawings on that 
board and the total number of drawings on that board. Click on that number to 
open a WatchList of those symbols, move all the drawings from that board to 
another or to delete all of the drawings from that board. 

 
 
 
 
 

CREATING ALERTS FROM DRAWING TOOLS 
 

Trendlines and horizontal lines drawn on Charts can be used to create real-time alerts. Click any trendline or 
horizontal line on a Chart and select Set 
Alert from the menu displayed. 

 
Set frequency, expiration, and note 
information as desired; then select OK 
to finalize the alert. Review the alert 
within the Alerts dialog, which can be 
initiated by the Alerts button, located 
on the Main Toolbar. 

 
For more information about alert functionality, see the Alerts 
section of the user guide, which follows. 
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Alerts 
 

  WHAT ARE ALERTS AND HOW DO THEY WORK? 
 

Alerts are notifications received from TC2000 when certain events take place on a specific symbol's Chart. 
There are five types of alerts: Price Alerts, Trendline Alerts, Scan Alerts, Condition Alerts, and Reminders. 

 
Price Alerts trigger when an established price for an individual stock (or other issue) has been reached. 
Notification(s) for the event will depend on personally assigned notification settings. 

 

Trendline Alerts trigger when a personally drawn trendline on a Chart has been violated. Note that to create a 
trendline alert, click the trendline (or horizontal line) of interest on a Chart and select Set Alert from the menu 
displayed. Notification(s) for the event will depend on personally assigned notification settings. 

 

Scan Alerts monitor an individual stock for particular behavior(s). When the item being monitored meets the 
Conditions of the scan, the alert triggers. The scan used in a Scan Alert is chosen from the library of saved 
scans.  Notification(s) for the event will depend on personally assigned notification settings. 

 

Condition Alerts monitor either an individual stock or a group of stocks (or other items) for a particular 
behavior. The behavior monitored is based on the selection of a Condition from the library of saved 
Conditions. When one or any of the items being monitored meets the Condition, the alert triggers. 
Notification(s) for the event will depend on personally assigned notification settings. 

 

Reminders are set for an individual stock (or other item) and are assigned a particular reminder date. 
Notification(s) for the reminder will depend on personally assigned notification settings. 
 
The easiest way to initiate an alert is to Right Click anywhere 
on the chart, select Set Alert for (sym) and then choose the 
type of alert desired.  
 
Depending on the type of Alert, make the selections as to 
conditions, symbol and Alert Name. Common to all alert 
types is the Restart option. Choose whether to restart the 
alert (if unchecked, the alert will not be restarted after it 
fires). If you choose to restart it, choose when (after it fires 
the first time) it should restart. Also, choose how long to 
monitor the alert.  
 
Leave a description to and make any changes to the notification 
settings that may be desired (optional). 

 
Any existing alerts can be viewed and managed by the Alert Console, 
which is accessible using the Alerts button, located on the Main 
Toolbar.  The Alert Console generated by the Alerts button includes 
options for managing existing alerts; alerts account information; 
delivery settings options; the ability to create new alerts; the 
status of existing alerts and a list of all existing alerts with 
relevant information. You can also access the Alert Log from this 
menu. 
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The Alert Console displays any and all alerts.  Symbol, Date Created, Name, Status with status light, and 
Management columns are all displayed for this type of alert. 
 
The console gives you an easy, visual way to see the 
current status of all your alerts: the status lights. 
• A Green Light—means the alert is currently running 

and actively being monitored by TC2000 servers 
• A Yellow Light—means the alert has triggered, but is 

now paused waiting for the restart time you set. At 
that point that alert will restart and be actively 
monitored again 

• A Red Light—simply means the alert is no longer 
being monitored at all 

 
Within the Alerts Console, use the New Alert button to initiate the creation of any new 
alert. Trendline Alerts cannot be initiated in this way and must be initiated by the 
selection of a trendline from a Chart.) For all other types of alerts, select the desired 
alert type from the menu provided and follow on-screen commands within type-specific 
dialogs to assign alert settings. Once created, the new alert will be displayed in the Alert 
Console. 

 
Use the Notifications button to assign delivery settings for any triggered alerts.  Add, 
delete, activate, or deactivate any Email address for delivery from this location.  Select 
one of the Email addresses to either change the address assigned or to activate the Text 
Message option. Then set in- application alert settings for single symbols and lists of 
symbols below. 

 
By default, when an alert expires, it is removed from the displayed list in 
the Alert Console.  To view expired or completed alerts, place a check 
mark in the box located next to Show Old Items. Toggle this option 
based on desired view. 

 
 

Select the Alert Log button to initiate the Alert 
Log window, which may be left floating (as it is by 
default) or may be docked or tabbed in 
accordance with standard screen real estate 
operations for TC2000 v12.4. Within the Alert 
Log window, use the Time Period drop-down to 
assign the number of days of information that 
should be displayed. Also, assign whether list 
alerts should be displayed using the check mark 
next to Include List Alerts. Information included 
in the log is for any alert that has triggered 
historically.  Data displayed for each triggered 
alert includes Date and Time, Relevant Symbol, 
Status when Triggered, Name of Alert, and icons 
for Chart view and individual symbol log 
information. 
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Notes & News 
 
 

                                      NOTES & NEWS IN THE TC CLASSIC LAYOUT TABS 
 

Notes are content written by a user associated with a specific symbol. News is content published by either a 
journalistic news source or to a social media outlet such as Twitter. Notes and News from a variety of sources 
are all aggregated inside TC2000, such that when researching Charts, related news for Chart symbols is 
available at your fingertips. 

 
The types of Notes and News available include the following: 

• Personal notes you have written for a symbol 
• Notes of other TC2000 users you choose to follow 
• News aggregated from journalistic news sources 
• Symbol-specific Twitter posts 
• Symbol-specific Corporate Calendar events (Platinum only) 

 
The TC Classic and TC Classic+ Layout Tabs include three Notes & News windows by default: All, My Notes, and 
Following. 

 
The All window includes all of the types of posts 
included in the list above. As articles or posts 
are created, they instantly become visible within 
the All window. The My Notes window displays 
notes that you have personally written or that 
you have copied from another Notes & News 
window. The Following window displays posts 
written by other TC2000 users who you have 
specifically chosen to follow. 

 
In addition to the windows listed above, the TC 
Classic+ Layout Tab also includes the Corporate 
Calendar (Platinum only) 

 
Things to Remember about Every Notes & News Window: 

 
1. A check in the Symbol box means that only posts related to the current 

symbol will be displayed within the window. By default, the Symbol Linking 
color group for Notes & News windows is yellow, which means the symbol 
for which information is displayed will change any time any other symbol 
within the Layout Tab is selected. Remove the check from the Symbol box 
to show the most recent posts related to all symbols. 

2. When a check in the Symbol box is present, a list of symbols is displayed 
along the left side of the window. The list contains symbols most-recently 
posted about, so that while the posts within the window are related only to 
the symbol you've most-recently chosen, it is still possible to see what 
symbols other users and news sources are posting about. 
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3. If content is streaming into a window quickly, click the 
Streaming button to pause it. 

4. If you want to change the type of content displayed within a 
Notes or News window, click the Edit button in its upper-
right corner. 

5. For posts related to full articles, click the Read Story link to 
view the entire story text. To write a comment on a post, 
click the Comment button and enter text. 

6. Any post from any Notes or News 
window can be copied to your My Notes 
window.  Click the name of the author 
and choose Copy Post to My Notes. 

7. If you come across a post and want to 
view all posts by the same author, click 
the name of the author and choose 
View "Author". You could also choose 
to Follow that author so that all of their 
future posts would automatically show 
up in your Following window. 

 
 
 
 

  CREATING NOTES FOR CHARTS 
 

Notes that are written can be either general or symbol-specific.  To write a notes, use one of these methods: 
Hit Shift-N on the keyboard to initiate a note; select the Notes & News button on the Main Toolbar and select 
Write Note; or within a My Notes window that is already 
opened, click where prompted to write a note. 

 
When you initiate a note, the current symbol is included in the 
note body as a clickable link in this format: $SYM. Other 
symbols included in the note written in the same format will 
also be clickable links that are tied to any Charts that share the 
same Symbol Linking color group (as the output color group 
assigned  in the Notes or News window). 

 
Charts, WatchLists, EasyScans, and Layout Tabs can all be 
attached to notes. When an attachment is included with a 
note, a copy of the attached item can be opened directly from 
the post in a Notes window in the future. 

 
Notes can be posted privately or can be posted publically.  To post a 
note privately, select Post to Myself when finished drafting the note. 
Only you will have access to a privately posted note in the future. 
To post a note publically, choose Post Shared when finished drafting 
the note.  Notes posted publically are visible for others who are 
following your posts and for those who choose to view a window of 
All TC2000 User Notes. 
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To view a list of your notes in the future, either view the My Notes window 
included in the TC Classic and TC Classic+ Layout Tabs, or select the Notes & News 
button on the Main Toolbar, and choose My Notes. Once the My Notes window is 
visible, to view only notes for the current symbol, place a check in the Symbol box 
in the upper-left corner. To view a list of all previously written and copied notes, 
remove the check from the Symbol box. 

 
It is also possible to sort a WatchList by most recent note date. Use the Add 
Column button within a WatchList and choose My Notes from the Basic 
Columns section. Then sort by the column by clicking its header to find the 
most recent notes. 

 
Remember that posts found in other Notes and News windows can be copied 
to your personal Notes window.  Click the name of the author whose post is 
being copied, and select Copy Post to My Notes. 

 
 
 
 
 
 
 
 

  NOTES & NEWS BUTTON (MAIN TOOLBAR) 
 

From the Notes & News button on the Main Toolbar, all of the following can be done: 
 

• Various Notes and News windows can be generated 
• Your Profile, including followers and people followed, can be managed 
• New personal notes can be initiated. 
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The following menu items with corresponding functionalities are located within the Notes & News button: 
 

All Notes & News 
Opens a window with the streaming feed of all News, Personal Notes,TC2000 User Notes, Twitter Posts and 
Corporate Calendar (Corporate Calendar is a Platinum exclusive feature). 

Peter Worden Notes & Reports 
Opens a window with the aggregated notes and nightly Worden Reports from Peter Worden (see below). 

Write a Note - 
Generate a new note window for a personal note. 

My Notes - 
Generate a window containing only your personally written and copied notes and/or posts. A My Notes 
window is part of the TC Classic and TC Classic+ Layout Tabs by default. 

More Feed Options 
View a list of various types of notes content that can be generated. Of note are the All TC2000 User 
Notes, Custom Feed Windows and Corporate Calendar items. 

• Choose All TC2000 User Notes to generate a window that 
includes posts written by any other TC2000 User that was 
shared publically. 

• Choose Corporate Calendar (Platinum only) to view a list of 
upcoming managerial and financial events for publicly traded 
companies, including General Meetings, Conference Calls, 
and Earnings Announcements. 

Search TC2000 User Notes - 
Search for a specific TC2000 User by name and generate a window 
that includes any of their publically posted notes. 

My Profile - 
Adjust name display settings, the list of people whose notes and posts are 
being followed, and manage an Ignored Users list.  Add a user to the 
Ignored Users list if their publically posted content should not be visible in 
your Notes and News windows - and should not be visible within a User 
Group that's being viewed.  
 

                 PETER WORDEN NOTES & REPORTS 
 
The daily Worden Report and Notes from Peter Worden contain technical 
analysis lessons on individual stocks, ETFs or Indices (Worden Notes) as 
well as the evening overview of current Market conditions (Worden 
Report). 
 
Use the spacebar to move consecutively through the WatchList from the 
stocks with most recent notes back. Use the scroll bar along the right side 
of the notes to scroll “blog” style through all comments on an individual 
symbol. 
 
Click on the Reports Tab to see the nightly Worden Reports arranged from 
the most recent back. Use the scroll bar on the right of the 
reports to view previous notes. 
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User Groups 
 
 

  WHAT ARE USER GROUPS AND HOW DO THEY WORK? 
 

User Groups (Platinum only) are channels of communication between you and other TC2000 users.  It is 
possible to communicate with others individually through Private Messaging, 
or as a group through User Groups. 

 
All User Group options can be accessed by the User Group 
button located in the upper-right corner of the application. 
Click on the desired group name to open a chat window for 
that group. 
 
Click to chat where prompted within a room. Charts, 
WatchLists, EasyScans, and Layout Tabs can be attached for 
others to view by the Attach button within the User Group 
editor. 

 
Within the User Group dialog, you can search for the name of any of the 
rooms you may have been a member of in a previous version of TC2000. 

 
 

Within a User Group window, click a poster's 
name to access a menu of options, including 
Follow, View Notes, Send Private Message, View 
Profile, Ignore, Report as Inappropriate, and Copy 
Post to My Notes. To manage your Ignored list, 
visit Notes 
& News > Profile> Ignored Users. 

 
 
 

You can also initiate your own room by the Create 
User Group button. Provide a name, and use the Edit button to invite other 
TC2000 users to join. 
 
Use the Private Messages tab within the User Group dialog to send a one-on-
one message to another user. The people you're following are listed for easy 
access. Click a name to begin a private message.  Click where prompted to type 
your message; Charts, WatchLists, 
EasyScans, and Layout Tabs can be 
attached to private messages.  Use the 
Create User Group button within a Private 
Message to create a User Group that 
includes you and your messaging partner. 
Other users can then be added to the 
room. 
 

Chat 
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Appendix: Personal Criteria Formulas 
 
 

  BOOLEAN VS. EQUATIONS - MAKE PCFS MORE VERSATILE 
 

All personal criteria formulas (PCFs) can be split into two different categories or styles. All PCFs are either 
Boolean with logical operators (<,>, or =) or equations (no logical operators and return a range of values). Though 
there is nothing wrong with Boolean PCFs, PCFs written as equations are more flexible and offer many 
advantages. 

 
If you want to find stocks that had higher volume today than yesterday, your first instinct might be to write the 
Condition like: 

 
More Volume Today 
V > V1 

 
"V" is today's volume and "V1" is the volume one day ago (yesterday). There is nothing wrong with the formula 
above and it would work perfectly to find what you wanted. Now say you also wanted to find stocks where the 
volume today was lower than yesterday. You would need to create a second formula: 

 
Less Volume Today V 
< V1 

 
Later you may want to find stocks with the same volume as the day before: 

 
Equal Volume Today and Yesterday 
V = V1 

 
You may want to find stocks with the volume 100,000 shares higher today than yesterday (volume in TC2000 v11 
is NO LONGER reported in 100s): 

 
100,000 More Volume Today than Yesterday V 
> (V1 + 100000) 

 
Though the above PCFs are completely accurate and would find what you are looking for, you can find all of these 
Conditions with only ONE PCF: 

 
Volume Net Change 
V - V1 

 
In essence you use PCFs not to find the Condition you seek but to furnish the data needed to later isolate certain 
stocks.  By using subtraction instead of a Boolean operator you can find any type of relationship between the 
volume today and yesterday's volume with only one formula! Boolean PCFs give only two potential results; every 
stock in the system returns either a "True" meaning the stock meets the formula's requirements (Today's volume 
IS higher than yesterday) or it returns a "False" meaning the stock does not  meet the requirements (Today's 
volume IS NOT higher than yesterday). With Boolean logic, a PCF splits all the stocks into only two groups (True 
and False). A PCF written as an equations (like V-V1) returns a value for every stock in the system. 
Equation PCFs can be limited using the range selector in the Edit Scan dialog for any scan being performed. 

 

55 TC2000 12.4 User Guide 
 



 

Using the range selector, you dictate how to limit the relationship. To find stocks that had more volume today 
than yesterday, limit Volume Net Change to only values greater than zero. Lower volume is found by limiting 
the range to only negative values. To uncover equal volume stocks limit the values to zero.  Isolate stocks with 
100,000 shares or more by limiting values to 100000 to MAX (100,000 or higher). PCFs written as equations also 
make great sort criteria, unlike Boolean criteria, because they return a range of values to rank stocks versus 
each other with. 

 
Writing PCFs as an equation is easy if you use the following guidelines: 

 
1. Make your PCFs return a value by making them equations. 
2. Every time you would use a logical operator, you can replace it with subtraction or division to make it 

an equation. 
3. Use a PCF to extract information about a Condition or relationship. Use scan, or sort, to later isolate 

the stocks based on that relationship. 
 

When looking for a single element with a certain value, instead of locking the value range in the PCF itself with a 
Boolean operator, make the PCF return the values for the single element and use the range selector in a scan to 
set the value range desired (TSV19 instead of TSV19 > 0). 

 
If looking for one element to be more, less or equal to another element, instead of using a Boolean operator, use 
subtraction to get the net difference or division to return the ratio between the elements. With the net 
difference or ratio, you can set the range of values to find the type of relationship you need. 

 
EQUATION TEMPLATES 

 
To make it easier writing your formulas as equations, here are a few templates to work from: 

Percent Change 
(X - Y) / Y *100 
Where X is the most recent element (The most current value like today's value), and 

Y is the older element (the previous value like yesterday's value) 
 

Dividing the difference of a recent and past element then multiplying it all by one hundred makes an equation a 
percent change. 

One vs. Another - A Ratio 
X / Y 
Where X is one element and Y is the other element 

 
This format gives the ratio between two separate elements. Values of "1" for this equation mean that X and Y are 
equal. Values greater than "1" indicate X has a higher value than Y, values less than "1" indicate Y is greater in 
value than X. A value of "2" indicates that X is twice the value of Y; a value of .5 indicates that X is half the value of 
Y, etc. 

One as a Percent of Another 
X / Y *100 
Where X is one element and Y is the other element 

 
This format is the same as One vs. Another except the result is multiplied by one hundred to make the results 
indicate what percentage of Y is the value of X.  Values of 100 mean X is 100% the value of Y (they are the same). 
A value of 50 designates X is 50% the value of Y (X is half of Y) and a value of 300 means X is 300% the value of Y 
(X is three-times the value of Y). 
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  USING SUBTRACTION VS. DIVISION 
 

To know when to use either subtraction or division, decide if the raw original values should influence the result 
or if the raw original values should not be a factor. As an example, compare today's price to yesterday's price. 
Imagine stock ABC has a price per share of $150 yesterday and a price of $165 today. Also assume that stock 
XYZ has a price per share of $1.00 yesterday and a price of $1.10 today. If you want the two stocks to return 
different values sensitive to their difference in pricing, you want to use subtraction and create a net change. 

 
Net Change: C - C1 
Stock ABC: 165 - 150 = 15 
Stock XYZ: 1.10 - 1.00 = 0.10 

 
With Net Change the results give Stock ABC a greater value for the criterion than Stock XYZ due to the difference 
in their price level. 

 
If you want to discount, normalize or ignore the difference in their original values you want to use division and 
create either a ratio or a percent change. 

 
Percent Change: (C - C1) / C1 *100 
Stock ABC: (165 -150) / 150 *100 = 10 
Stock XYZ: (1.1 - 1) / *100 = 10 

 
With a percent change, the stocks return equal values because using division negates the difference between the 
prices of the stocks and only reveals the values relative to each other. 

 
Typically experimenting with both subtraction and division and then sorting a list by the results reveals the one 
to use in any given situation. 
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  PCF SYNTAX BASICS 
 

The syntax or language for writing Personal Criteria Formulas is very simple. This table explains the available 
elements and their purpose and meaning. Use the example formulas in the appendix to increase your ability to 
combine these elements accurately and efficiently. 

 
 
 

Element Meaning Returned Element Meaning Returned 
O 
H 
L 
C 
V 
AVG 
MAX 
MIN 
STOC12.5 
RSI30.9 

Open Price 
High Price 
Low Price 
Closing Price or Last Price 
Volume 
Average of the Values 
Highest of the Values 
Lowest of the Values 
Stochastic 12,5 
Wilder's RSI 30, 9 

BOP1 One Day Average of BOP 
TSV19 TSV with a Period of 19 
* Multiply 
/ Divide 
+ Add 
- Subtract 
ABS() Value negating positive or negative 
LOG() Log of a value 
EXP() Exponential of a value 
SQR() Square of a value 

 
 
 
 
 

Example - Range vs. Average Range 
 

 
Purpose: Determine if today's daily spread or range is abnormally high or low for the stock as compared to its 
average range. 

 
Step 1: Decide what type of symbols or circumstances you are seeking. 
You want to know how the size of today's bar compares to the normal daily trading range of the stock in order 
to find abnormally high or low activity. 

 
Step 2: Decide what information you need to extract from TC2000 to find the desired symbols or 
circumstances. 
You need to know two things about every stock to find where the close is as a percent of the daily range: 

 
1. What today's range is 
2. What the stock's average range is in the past 

 
Step 3: Manipulate the information extracted from TC2000 to uncover what you are looking for. 
Once you know how today's range compares to the average range for a stock, you can determine if today's 
range (or spread) is higher or lower than normal. This should help you uncover stocks experiencing abnormal 
activity. 

 
Formula: 
(H - L) / (AVGH60 - AVGL60) *100 
*This formula represents the current price bar range as a percentage of the 60 bar average price bar range. 
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	Welcome
	Welcome to the updated TC2000 v12.4!
	TC2000 is a market analysis software that has been designed to combine an easy-to-use interface with feature flexibility, so that with little prep time, you can start to use the software to enhance the way you trade.
	This reference should serve as a guide to software features and their implementation. The guide is designed to discuss the logistics of designing a personal trading environment, from screen real estate manipulation to charting and organizational funct...
	There are no trading strategies or instructions here; this guide offers no trading advice, so you should not make any trading decisions based on any information contained here.
	Should you encounter inaccuracies or material that requires correction, please feel free to make note of needed modifications.  Send such notes to support@TC2000.com.
	Call TC2000 toll-free to set up a TC2000 account or to have questions about an existing account answered. (800) 776-4940

	Accessing TC2000 v12.4
	If you are a current TC2000 customer with TC2000 service...
	If you are not a current TC2000 customer and do not have a TC2000 login:

	What's New in TC2000 v12.4
	1. Charts are up to 300% faster. As you spacebar through any WatchList, you’ll notice snappy charts that load instantly. Alerts are also faster and easier to manage.
	2. Whether you’re working with one monitor or four, floating windows will give you a ton of new options for laying out your research.
	3. Full multiple monitor support. Drag any Layout Tab window onto any monitor. No limitations on the number of monitors and setups can be saved for future use as Layout Tab groups.
	4. The new Add Plot button (shortcut key ‘/’) allows you to browse a library of all available chart data that can be plotted including Technical Indicators, Fundamental data, Sector and Industry Indexes, Market Indexes, Breadth Indicators, Exchange Tr...
	5. An upgraded pointer mode allows you to select a date and view detailed chart data for all chart indicators at that specific point in time. For charts with different timeframes, notice that the pointer now works across charts.
	6. Data box details have been expanded to include descriptive figures for chart spans. Drag the pointer between any two points on the chart to measure number of bars, performance, and annualized returns.
	7. Drawing Tools are now on every chart. Click the Paint Palette in the upper-right corner of any chart to open the Drawing Toolbar. Fibonacci Projections have been added to the library of available drawings. When drawing Trendlines, hold the Shift ke...
	8. Drawings can now be assigned to specific Drawing Boards, which act as layers that keep drawings of different types separate. Any of the eight boards can be toggled on or off at any time for any chart. Use the Scratch board for a particular chart te...
	9. Apply technical indicators to anything - including historical fundamentals, sectors, industries, T2 market indicators, or any other technical indicator.
	10. Historical fundamental data can now be plotted and used for sorting and EasyScans. Fundamental figures such as sales, dividends, and key ratios include 25 years of historical data.
	11. Open a Related Items WatchList to learn more about any symbol. You’ll see any Indexes and Exchange Traded Funds the current symbol is a part of. You’ll also have immediate access to lists of all the stocks that share the same Sector or Industry ca...
	12. The Worden Notes & Reports are easier to access and more efficient to use.

	TC2000 v12.4 Account Management
	Terms to Know
	Layout Tabs
	WHAT IS A LAYOUT TAB?
	CUSTOMIZING A LAYOUT TAB
	Adding Windows to a Layout Tab
	Repositioning & Resizing Main Toolbar
	Reposition
	Resize

	Tool Window Controls
	Move
	Full Screen Mode (Maximize)
	Delete
	Tool Linking
	Linking Symbols
	Linking Timeframes

	Save
	Change List/Scan Properties
	Load Columns
	Change Symbol or View Chart


	CREATING NEW LAYOUT TABS
	SAVING AND RETRIEVING A LAYOUT TAB
	LAYOUT TAB GROUPS
	FLOATING A WINDOW

	Charts
	WHAT IS A CHART?
	CHARTS BUTTON (MAIN TOOLBAR)
	CONTROLLING THE ACTIVE TICKER SYMBOL
	Activating Scrolling Ticker
	Toggle Scrolling Ticker
	To activate a scrolling list of symbols across the top of your TC2000, click on the Tools Menu on the main toolbar and choose Show Scrolling Ticker.

	Edit Scrolling Ticker
	To edit the Scrolling Ticker click on the Edit button at the extreme right of the scrolling ticker window. Use this window to choose any WatchList in your TC2000 to scroll using the drop down. Change the speed (faster or slower) with the slider bar. C...


	CHART DISPLAY SETTINGS
	Price Graph Type
	Price information can be displayed in several different styles, which are described individually below. Left- click the Price plot, and select the Edit option in order to assign a style to the Price plot.
	The Price plot has four components available for each time increment: Open, High, Low, and Close. The Line plot style draws a point at the Price Close value for each date, as illustrated in the graphic below. Each point is then connected by a line to ...
	The Price plot has four components available for each time increment: Open, High, Low, and Close. The OHLC Bar plot style only displays all four of the available pieces of Price information for each date or time: Open, High, Low, and Close. For each h...
	The Price plot has four components available for each time increment: Open, High, Low, and Close. The HLC Bar plot style only displays three of the available pieces of Price information for each date or time: High, Low, and Close. For each historical ...
	The Price plot has four components available for each time increment: Open, High, Low, and Close. The Candlestick plot style displays all four components of Price for each historical date.
	A candlestick may either be opaque or transparent. An opaque candlestick represents the four Price components as labelled in the graphic below. A transparent candlestick represents the four Price components as labelled in the graphic below.
	The Bar plot style is typically used to display non-Price data (i.e. indicator values) in a specific style. The Bar plot style draws a solid column from zero to the indicator value for each date or time, depending on the time- period increment. Time-p...
	The Price plot has four components available for each time increment: Open, High, Low, and Close. The Area plot style draws a point at the Price Close value for each date. Each point is then connected by a line to the next point on the Chart, much lik...

	Chart Timeframe
	The Timeframe drop-down sets the amount of time associated with each bar. If set to 1 Day the Chart will plot a daily Chart with one trading day assigned to each bar. All of the Timeframes in TC2000 are calendar based. As a result, a weekly Chart assi...
	To the right of every Timeframe listed within the drop-down, is the hotkey associated with that Timeframe. Pressing the hotkey on the keyboard changes the Timeframe of the Chart. For example, press the 1 key on the keyboard to change to a daily Chart....
	Intra-day Timeframes have two-key combinations for their hotkeys, including CTRL and a numeric key.
	(See the Tool Linking section of this user guide for more information about grouped Chart Timeframe assignments.)

	Chart Scaling
	Scaling Method
	Increase or Decrease Grid Spacing
	Show Ruler
	Ruler Settings
	Date and Scale Margin Sliders

	Chart Aesthetics

	CROSSHAIRS
	To activate a temporary Crosshair on the Chart and view values for all Chart indicators relative to the position of the crosshairs, hold the left mouse button down and drag the cursor to the desired location on the Chart. The crosshair pointer shows t...
	Click the background of a chart to activate the pointer. Select a date to view detailed chart data for all chart indicators at that specific point in time. Data box details have been expanded to include descriptive figures for chart spans. Drag the po...
	For charts with different timeframes, notice that the pointer now works across charts. Place the pointer on a longer timeframe bar, and the pointer highlights the relevant chart history on all shorter timeframe charts.
	To keep the Crosshair Pointer and the data box on the screen (without the mouse) press the Period key once for just the crosshairs and twice for both the crosshairs and the data box. Press the period key again to disable both.
	Both the temporary and permanent versions of the crosshair can be activated by the Drawing Tools menu as well. Select the Cross option within the Drawing Tools menu to initiate the crosshair with data box; select the Plain option within the Drawing To...

	INDICATORS IN TC2000
	Adding Plots to a Chart
	There are several ways to add a plots to a Chart in TC2000 v12.4. Each is discussed below.
	Select the Indicators section of the Library button located on the Main Toolbar.  Either manually locate the plot of interest using the scrolling ticker located along the right edge of the indicator list, or type to search for a plot of interest by ke...
	As an alternative to the Indicators button on the Main Toolbar, select the Add Plot Icon to open a menu of all library plots including any indicators you have created and saved. You may type within the Search field at any time to limit the list based ...
	Note that if the selection made is a child plot - meaning its calculation is based on the value of some other plot that needs to be assigned - you will be prompted to assign the parent plot from a list of all other indicators currently included on the...
	As an alternative to using the Add Plot button, try hitting the forward slash key / on the keyboard to initiate a search dialog. Type the name of the plot of interest, and once located within the search results list displayed, select it with the mouse...
	Plots added using the Add Indicator button as described are added to new individual panes by default. It is possible to add a plot to a pane that already exists and that contains another indicator or plot. To add a plot to an existing pane, left-click...
	A scale for the added plot is made visible within the pane that now contains two or more plots. Use the right-facing arrow located in the lower right corner of the Value Scale area to toggle through scale visibility modes. View scales for one or all i...
	Use the Move button located to the left of every plot to initiate the on-screen prompts that allow the selection of any of the described movement options.
	Select any of the directional arrows displayed to move the selected plot or pane above or below an existing pane; select the Overlay option displayed on other existing panes to assign both plots to the same pane; or choose Pin to hide the contents of ...
	Plots available for display in chart panes are:
	 Technical indicators—over 70 modern technical indicators
	 Historical Fundamentals—70+ fundamentals with up to 25 years of historical data
	 Industries—Morningstar Sector and Industry breakdowns
	 Indexes—Over 330 different US Market Indexes
	 T2 Market Indicators—25+ Market Indicators (market internals and breadth indicators)
	 ETFs—1500+ Exchange Traded Funds
	 4x (Forex)--Over 55 Foreign Currency Pairs
	 Price Charts Other Symbols—plot any other symbol as a separate price plot on the same chart
	 Custom Personal Criteria Formula (PCF) Indicators—custom formula based indicators
	All data streams in real-time according to your level of service.
	 Gold: streaming 15-minute delay (plus BATS real-time data)
	 Platinum: streaming, full market real-time.
	Managing Plots on a Chart

	Viewing Historical Charts

	CHART TOOLBAR
	SAVING AND RETRIEVING A CHART

	WatchLists
	WHAT IS A WATCHLIST?
	Selecting a WatchList
	To view the contents of a specific WatchList, click the WatchList drop-down, and either locate the desired list name manually using the scroll bar along the right edge of the menu, or begin typing to limit the list based on keyword. You may also use t...
	Note that selecting a WatchList from the WatchList button on the Main Menu generates the new list in a floating window that can be left floating or docked or tabbed with another window or group of windows within the Layout Tab. Selecting a WatchList f...

	WatchList Menu Categories

	WATCHLISTS BUTTON (MAIN TOOLBAR)
	SORTING A WATCHLIST
	WatchLists can be sorted by symbol, indicator value, or Condition. Any of these sorts can be performed in ascending or descending order.
	Sorting by Symbol
	Left-click the Symbol column header located in the WatchList header area. The initial sort order will be ascending, from A to Z. To change the sort order to descending, left-click the Symbol column header once more.

	Sorting by Plot Value
	Sorting by a Condition
	Any Condition may be used to sort a WatchList, identifying the items in the list that pass the Condition with a colored check mark. Click any indicator on a Chart and select Create Scan Condition to set up a behavioral criteria for the plot selected. ...
	On-screen prompts provide a choice to either Add Column, in which case a check mark is placed next to any item within the WatchList for which the Condition is true - or - to Add Column & Sort, in which case the items within the newly added column that...
	The position of Condition columns can be adjusted once the column is present in a WatchList.  Right-click any Condition column header, to edit, move, save, or delete the column.
	It is also possible to use a previously saved Condition to create a Condition column within a WatchList. This can be accomplished in one of two ways. Either select the Add Column button located
	to the right of any column headers within the WatchList of interest and locate the Condition within the My Conditions sub-category, or select the Conditions section of the Library button located on the Main Toolbar, and select a previously saved Condi...


	CREATING AND DELETING A WATCHLIST
	WATCHLIST AESTHETICS
	RELATED ITEMS WATCHLIST
	CONTROLLING THE ACTIVE SYMBOL
	Sorting by Fundamentals



